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New Features

The following new features have been added in this release of TIBCO ActiveMatrix Service Grid:

Jetty Upgrade

In ActiveMatrix Service Grid 3.4.1, the Jetty version for HTTP Connector resource templates is upgraded
from version 9.2.25 to 9.4.41.

For details, see the Configuring and Preparing HTTP Connector for Jetty 9 section in TIBCO ActiveMatrix®
Service Grid Administration.

TIBCO EMS Client Upgrade

TIBCO EMS Client version is upgraded from version 7.0.1 to 8.5.1.

Log4j is Replaced with reload4j

Log4j is replaced with reload4j ( reload4j-1.2.19.jar).

Support for Mutual SSL Authentication

Mutual SSL authentication is now supported between ActiveMatrix Service Grid and TIBCO EMS (both
Messaging Bus and Notification Server).

Support for Explicit Ciphers

You can now use explicit ciphers in SSL Client Provider resource template when creating connection with
SSL enabled EMS. You can specify list of ciphers in the SSL Client Provider resource template Explicit
Cipher List field.

Testing Connection to JDBC Resource

With this release, you now have the option to test the connection of JDBC shared resources by performing a
test connection on the resource when you add or edit the shared resource by using the Administrator UI or
CLI. Thus, if the configuration is incorrect, for example, wrong credentials are specified, you can update the
configuration and resolve the issues and avoid failures at the time of invocation. The test connection can be
disabled if required. For details, see Testing Connection to a JDBC Resource section in TIBCO ActiveMatrix®
Service Grid Administration.

JRE Upgrade

With the current release, the Java Runtime Environment (JRE) is upgraded to JRE 1.8 Update 321.

Support for Oracle 18c, 19c, and 19c RAC

TIBCO ActiveMatrix Service Grid now supports Oracle 18c, 19c, and 19c RAC.

Support for PostgreSQL

TIBCO ActiveMatrix Service Grid 3.4.1 supports PostgreSQL versions 11.5 and 10.7.

Support for Oracle Database Server 12c with Transparent Application Failover (TAF)

TIBCO ActiveMatrix Service Grid now supports Oracle Database Server 12c with Transparent Application
Failover (TAF) using Oracle 12C R2 JDBC Driver 12.2.0. This is certified for TIBCO ActiveMatrix runtime
only. There is no TIBCO Configuration Tool (TCT) support. Contact TIBCO Support for enabling Oracle
OCI driver with TAF feature.
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Changes in Functionality

No functionality changes have been made in this release.
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Changes in Platform Support

In this release, platform support for ActiveMatrix Service Grid has changed as follows:

Platforms Status As of Release

Red Hat Enterprise Linux
Server 8.x

Added 3.4.1

Microsoft Windows Server
2019

Added 3.4.1

IBM AIX Removed 3.4.1

HP-UX Removed 3.4.1

For a complete list of all the currently supported platforms, see the readme file.
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Deprecated and Removed Features

The following features have been deprecated or removed in this release.

Deprecated Features

Affected
Component Description

Deprecated in
Version

Log Service and
Payload Service

Log service and payload service are deprecated in this
release.

3.4.1

TIBCO
ActiveMatrix®
Service Performance
Manager

ActiveMatrix® Service Performance Manager is
deprecated in this release.

3.4.1

Database Oracle Database 12c, 12c RAC, 12.1.x, 12.2.x 3.4.1

Removed Features

Affected
Component Description

Deprecated
in Version Removed in Version

ActiveMatrix
Administrator
Dashboard

The TIBCO ActiveMatrix
Administrator dashboard
(Dashboards > Infrastructure) is
removed.

You can check the status of all
ActiveMatrix entities (nodes, hosts,
applications, and resource instances)
from the Infrastructure > Enterprise
Status page. From this page, you can
also search for entities in an Enterprise
and perform specific actions on them.

3.4.0 3.4.1

Metrics Collection
Runtime (MCR)
Functionality

Starting from version 3.4.1,
ActiveMatrix Service Grid does not
support Metrics Collection Runtime
(MCR) functionality.

3.4.0 3.4.1

Publishing to
UDDI Server

The ability to publish Application
Services to Universal Description,
Discovery and Integration (UDDI)
Server using TIBCO ActiveMatrix
Administrator is not supported.

3.4.0 3.4.1
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Migration and Compatibility

For instructions on how to migrate from a previous release to the current release, see the TIBCO
ActiveMatrix® Service Grid Installation and Configuration Guide.

Product Compatibility

ActiveMatrix Service Grid 3.4.1 adds compatibility support for the following product versions:

● TIBCO Enterprise Message Service™ 8.6.0

● TIBCO® Operational Intelligence Hawk® RedTail 7.1.0

For complete list of compatible products and versions, see the Readme file.
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Closed Issues

The table lists closed issues in this release.

Key Summary

AMRP-5747 When applications in a TIBCO ActiveMatrix environment start, the order in which
an application's components start is random and non-deterministic. Due to this, in
case of TIBCO ActiveMatrix BPM, an incorrect version of the PageFlow component is
invoked, resulting in downstream errors.

With this fix, ActiveMatrix platform now sends the timestamp at which a component
was created, so that BPM layer can choose the order in which the Application
Components can be started.

AMRP-5746 The HTTP (Jetty) Server name, version, and SSL Cookie are revealed in HTTPS
response header without secure flag.

With this fix,

a) You can hide the Jetty server version from the response header for all HTTP
connectors running on a node by adding the following JVM property in the node
TRA file. When not set, the default value is false.

java.property.com.tibco.amf.node.disableSendServerVersion=true

b) If the HTTP connector is configured with SSL, then all cookies have the secure flag
set. For TRA property mentioned above it is not required.

AMRP-5743 In TIBCO ActiveMatrix Administrator, changes done to Request Header Size,
Response Header Size, and Output Buffer Size of SSL-secured HTTP Connector can
be saved using Administrator Server but are not honored by runtime. This issue is
fixed and Header and Buffer sizes are applied successfully.

AMRP-5733 TIBCO ActiveMatrix Administrator does not disable the HTTP DELETE method and
ActiveMatrix Administrator interface accepts requests for the HTTP DELETE
method.

With this fix, ActiveMatrix Administrator interface rejects the HTTP DELETE
method call with a HTTP/1.1 403 Forbidden error.

AMRP-5717 In TIBCO ActiveMatrix Administrator, Maximum Pool Size can now be specified for
SSL Client Provider Resource Template (RT) from the CLI. The new field is available
in the CLI when creating a new SSL Client Provider RT. You can also update the
value of Maximum Pool Size for existing SSL Client Provider Resource Templates.

Specifying the Maximum Pool Size is optional. If no value is specified, the default
value for Maximum Pool Size is 20 for SSL Client Provider Resource Template.

When you change the Maximum Pool Size of an existing Resource Template, all
Resource Instances of that Resource Template go in "Out of Sync" state, and need to
be re-installed using Administrator UI. After the Resource Instances are reinstalled,
the new value of Maximum Pool Size is applied to runtime.
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Key Summary

AMRP-5716 In TIBCO ActiveMatrix Administrator, Maximum Pool Size can now be specified for
SiteMinder Authentication Resource Templates (RT) using Command Line Interface
(CLI). The new field is available in CLI when creating a new SiteMinder
Authentication RT. The value of Maximum Pool Size can also be updated for existing
SiteMinder Authentication Resource Templates using CLI.

Specifying the Maximum Pool Size is optional. If no value is specified, the default
value for Maximum Pool Size is 20 for SiteMinder Authentication RT.

When you change the Maximum Pool Size of an existing Resource Template, all
Resource Instances of that Resource Template go in "Out of Sync" state, and need to
be re-installed using Administrator UI. After the Resource Instances are re-installed,
the new value of Maximum Pool Size is applied to runtime.

AMRP-5715 In TIBCO ActiveMatrix Administrator, Maximum Pool Size can now be specified for
the hidden Subject Identity Provider Resource Template (RT) that is created along
with JMS Connection Factory RT when Enable Authentication checkbox is selected
and Username + Password is selected for Login Credentials, from the CLI. The value
of Maximum Pool Size can be updated for existing Subject Identity Provider
Resource Templates using CLI.

NOTE:

● The scenario where Subject Identity Provider Resource Template (RT) is created
explicitly, that is, not hidden, is also addressed with this enhancement.

● For hidden Subject Identity Provider Resource Template (RT), the name of the
Resource Template created by Administrator along with JMS Connection Factory
RT is of the format
"<ParentJMSConnectionFactoryRTName>_userIdentityJNDIName". This name
can be found in Node logs or <adminURL>/viewdata.jsp or http(s)://
<adminHost>:<port>/amxadministrator/viewdata.jsp > Resource Template page.
This name is required for the subsequent steps to update the Maximum Pool Size.

AMRP-5714 In TIBCO ActiveMatrix setups upgraded to version 3.4.0, applications containing
WebApp Implementation Type (IT) with the context root as "/" stops functioning as
expected. This applies to applications deployed in the setup prior to upgrading to
TIBCO ActiveMatrix 3.4.0, as well as applications deployed after the upgrade.

After the fix, the applications now work as expected with the updated Jetty Server
API.

AMRP-5701 In TIBCO ActiveMatrix Administrator, if a user accesses an unauthorized page, the
Administrator server correctly returns HTTP response with error code "401"
indicating that the user is not authorized to access the page.

With this fix, this error response is now being encoded.
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Key Summary

AMRP-5699 In a TIBCO ActiveMatrix BPM setup (with TIBCO ActiveMatrix 3.3.0 Hotfix 018 or
higher), when the Java property
com.tibco.amx.cf.enable.virtualizationAddress.versioning is set to "true"
for the BPMNode, a NullPointerException is seen in the BPM Node logs when a
business operation is invoked immediately following the undeployment and
deployment of the user's BPM Application, or following a BPMNode restart.

With this fix, the issue is no longer seen and the operation invocation proceeds
without errors.

AMRP-5698 In TIBCO ActiveMatrix BPM setup involving ActiveMatrix BPM 4.2.0, a
NullPointerException is intermittently seen when the user's Oracle 12.1.0.2 database
is in a particular state with in-progress database transactions. This is a result of
erroneous creation of a global transaction with a "null" GLOBALID in the
DBA_PENDING_TRANSACTIONS table by one of the database users, which causes
failures, and the subsequent retries every 5 minutes eventually results in connection
pool exhaustion, as seen in the BPM logs.

With this fix, the retry is skipped for transactions with a "null" GLOBALID and the
NullPointerException is no longer seen. As a result the connection pool is no longer
exhausted.

AMX-18334 When strong ciphers are used with SSL enabled EMS server, using Configure SSL
option on the Admin Configuration > Admin Server > Transport Configuration tab
fails with an error.

AMX-18333 When ActiveMatrix Service Grid is configured with SSL enabled TIBCO EMS with
the following ciphers configured on the EMS, the connection between ActiveMatrix
Service Grid and EMS fails.

Ciphers configured in EMS:
ssl_server_ciphers ="-ALL:AES256-GCM-SHA384:DHE-RSA-AES256-
SHA256:DHE-DSS-AES256-SHA256:AES256-SHA256"

Ciphers configured in ActiveMatrix Service Grid SSL Client Provider resource
template Advanced tab:
TLS_RSA_WITH_AES_256_GCM_SHA384,TLS_DHE_RSA_WITH_AES_256_CBC_SHA256,T
LS_DHE_DSS_WITH_AES_256_CBC_SHA256,TLS_RSA_WITH_AES_256_CBC_SHA256

AMX-18332 When Explicit Ciphers are configured in the Advanced tab of SSL Client Provider
resource template, the connection to TIBCO EMS fails.

AMX-18220 Jackson databind library is upgraded to 2.11.4 to address security vulnerabilities.

AMX-18186 TIBCO ActiveMatrix Administrator does not retrieve blank values for Boolean type
application properties for some Administrator database types such as HSQLDB and
PostgreSQL, due to which the deployment of such applications fails with
XmlValueOutOfRangeException.

With this fix, the application with boolean property with blank value is supported
and the application is deployed or undeployed successfully.
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Key Summary

AMX-18164 With this enhancement, OpenID authentication supports PKCE  (Proof Key for Code
Exchange) with supported IDP. By default this feature of PKCE support is not
enabled. To enable PKCE support, you can select the Enable PKCE checkbox of the
'OpenID Authentication' resource template in ActiveMatrix Administrator GUI, or
set enablePKCE=true in the CLI build data file. For existing OpenID Authentication
resource instance, enabling PKCE in the resource template and saving the change
automatically triggers reinstallation of the corresponding resource instance and
restarts of the corresponding applications.

AMX-18152 ActiveMatrix Service Grid 3.4.1 supports Microsoft Windows Server 2019.

AMX-18090 During TIBCO ActiveMatrix Service Grid 3.4.0 upgrade, some shared resource
product features are ignored and not upgraded to version 3.4.0. Due to this
incomplete 3.4.0 platform upgrade, there are some TIBCO ActiveMatrix BPM 4.3
upgrade issue.

With this fix, all those previously ignored product features now get upgraded to
3.4.0, and both TIBCO ActiveMatrix 3.4.0 platform and TIBCO ActiveMatrix BPM 4.3
can be upgraded successfully.

AMX-18044 In TIBCO ActiveMatrix BPM 4.3.0 setup, applyPatch of ActiveMatrix 3.4.0 HF 002
fails due to exception:
EXCEPTIONS WHILE APPLYING PATCH TO HOST INSTANCE(S)
<hostInstance> : TIBCO-AMX-TOOLS-PATCHMGR-000001: error applying 
patch
amx.platform.patch:3.4.0.HF2 to TIBCO Host instance
Caused by: product feature com.tibco.amx.platform.patch.rpf 
3.4.2.000 contains
a release unit com.tibco.tct.admin.feature 1.6.1.003 that does not 
exist in the machine model

This issue is fixed by removing the feature com.tibco.tct.admin.feature from
the list of features included for patching. TCT features are not required to be patched
as they are only used in TIBCO HOME.

AMX-17757 Due to a restructuring of internal classes and packages carried out as part of TIBCO
ActiveMatrix 3.4.0 Hotfix 001, BPM User Applications configured to use LDAP
Connection Resource Template with SSL (LDAPS) fails with a
NoClassDefFoundError indicating the missing classes. These classes have now been
restored and the NoClassDefFoundError is no longer seen in the BPM.log.

AMX-17753 After upgrading to TIBCO ActiveMatrix BPM 4.3.0 (TIBCO ActiveMatrix 3.4.0
Platform, with or without 3.4.0 Hotfix 001), the old versions of some of the features
of BPM Applications are missing in the Node Feature Configuration following the
upgrade. With this fix, the issue is addressed and none of the features are missing
post-upgrade.

AMX-17694 In TIBCO ActiveMatrix BPM setups, if a TIBCO BPM Application is upgraded to a
newer version, in which some of the Components are removed, then the older
versions of these Components cannot be Started or Stopped in Administrator. This
issue has been addressed and now all versions of the Components within a BPM
Application can be Started or Stopped.
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Key Summary

AMX-17693 TIBCO ActiveMatrix Administrator does not correctly handle the operation of
adding Substitution Variables concurrently on a Node. If more than one thread
attempts to add Substitution Variable on the Node in parallel with another, the
operation fails with the following error:
TIBCO-AMX-CLI-000020: Error invoking bulk action add on 
SubstitutionVariable: 
org.hibernate.StaleObjectStateException: TIBCO-AMX-ADMIN-005484: The 
object 
'<NodeName' (internal id: NNN) appears to have been already modified 
by another user 
action or another thread. The current update is being reverted due 
to the conflict.
Retry your update action again. 

This issue has now been addressed and multiple Substitution Variables can now be
added concurrently to ActiveMatrix Nodes.

AMX-17676 With this fix, the property java.heap.size.max for NodeUtil utility has been updated
from 48M to 512M by default. This higher memory setting can be seen in the
NodeUtil.tra. The default memory has been increased to ensure that NodeUtil does
not run out of memory in case of long-running upgrades.

AMX-17590 In TIBCO ActiveMatrix Administrator configured with Authentication realm as
LDAP SSL, after upgrading to TIBCO ActiveMatrix Service Grid 3.4.0, each time the
SystemNode restarts, the users are unable to log in to Administrator with correct
login credentials within 1 hour or so, and the following exception is seen in the
SystemNode log:
[WARN ] [] com.tibco.amx.ra.authldap - Internal error: 
java.lang.NullPointerException.
java.lang.NullPointerException at 
java.util.Hashtable.put(Hashtable.java:460)

This issue also surfaces when users creates a new TIBCO ActiveMatrix Service Grid
3.4.0 setup with Administrator configured with Authentication realm as LDAP SSL.
With this fix, you can login successfully.

AMX-17584 TIBCO ActiveMatrix Administrator server does not support SSL-enabled TIBCO
Enterprise Messaging Server (EMS) fault-tolerant (FT) servers using JSON
configuration, and fails with the following error during EMS failover, as seen in the
SystemNode logs:
com.tibco.tibjms.admin.TibjmsAdminSecurityException: 
Command unavailable on a server not in active state and using a JSON 
configuration file 

With this fix, the failure is no longer seen, and SSL-enabled EMS FT servers
configured with JSON is supported for failover in a fault tolerant manner.

12

TIBCO ActiveMatrix® Service Grid Release Notes



Key Summary

AMX-17583 This issue is observed when failover happens in a large scale TIBCO ActiveMatrix
setup with Administrator configured with TIBCO Enterprise Messaging Server
(EMS) fault-tolerant (FT) servers, Runtime Nodes configured with the
tibco.tibjms.connect.attempts Java property, and the EMS server specified first
in the FT URL is not running. The user Applications on the Runtime Nodes cannot
be stopped or started because after the failover, the Runtime Nodes are unable to
send their status after successfully reconnecting to the EMS Server. The following
error message is seen in Runtime Node logs:
"com.tibco.amx.hpa.notification.NotificationGroup - TIBCO-AMX-
HPA-000308: cannot send status update message, notification service 
is unavailable and sending is suspended until notification service 
is restored".

As a result, ActiveMatrix Administrator marks these Runtime Nodes as "Offline" and
does not deploy any application on these Nodes.

With this fix, the Runtime Nodes can successfully transmit their status upon
connecting to the EMS server, and Administrator is able to mark the Nodes as
"Online" as a result, consequently allowing successful Application deployment.

AMX-17485 In an ActiveMatrix setup with Administrator configured with TIBCO Enterprise
Messaging Server (EMS) fault-tolerant (FT) servers, with Runtime Nodes configured
with the tibco.tibjms.connect.attempts Java property, when the EMS server
specified first in the FT URL is not running, the user actions of starting or stopping
SystemNodes and Runtime Nodes take a long time. This is due to the fact that when
starting or stopping SystemNode or Runtime Nodes with EMS FT configured, the
Nodes keep trying to connect to the inactive primary EMS server, instead of
connecting to the active, secondary EMS server.

With this fix, the issue is no longer seen and the Nodes now connect to the active
EMS server while starting or stopping without any delay.

AMX-17205 Apache Commons File Upload Library has now been upgraded to version 1.3.3.

BJMS-1587 In TIBCO ActiveMatrix, when Applications containing JMS or SOAP/JMS Binding
Types (BT) with Authentication enabled for JMS Connection Factory Resource
Template (RT), the services response is delayed due to the security update in Oracle
JRE, specifically when the JRE has been updated to JRE 7u161, JRE 8u151 or later.
Also, the username and password are being accessed from the keystore multiple
times while creating JMS sessions, which is excessive and unoptimized, and this
contributes to the increased response time.

This behavior has now been optimized thus improving the overall response time of
the JMS and SOAP/JMS services.

MED-3358 If a mediation app is importing a schema file and the schema location has space in
the file path then application deployment fails with MalformedURLException.

After this fix if schema location contains space then mediation application
deployment happens successfully.
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Key Summary

PD-4438 When failover happens in a TIBCO ActiveMatrix setup with Policy Director (PD),
with Administrator configured with TIBCO Enterprise Messaging Server (EMS)
fault-tolerant (FT) servers, Runtime Nodes configured with the
tibco.tibjms.connect.attempts Java property (with value set to 600,500), and the
EMS server specified first in the FT URL is not running, the Governance Control
(GC) deployment fails after EMS failover and went into "DeployError" state. This is
because after the failover, the Runtime Nodes kept trying to connect to the stopped
EMS server until all the attempts are exhausted.

This issue is now fixed and the runtime Nodes now connect to the active EMS server
immediately following the failover. Deployment of Governance Control is also
completed successfully after the failover.

PER-2191 In TIBCO ActiveMatrix Service Grid 3.4.0 setup with Policy Director Governance, the
"Authorization by Role" policy is not working for specific Roles. This is a result of
failure to retrieve the security token from the internal action context during
validation.

With this fix, security subject itself will carry the security token which will be made
available during validation, and "Authorization by Role" policy will work as
expected for the specific Roles usecase with Basic/Username Token Policy in place.

PER-2190 After Runtime Node restarts, the users are unable to invoke SOAP Binding Type
(BT) services configured with Authentication policy, which used LDAP
Authentication Resource Template (RT) with SSL. The following error is seen in the
Runtime Node logs:
com.tibco.amx.governance.agent.action.api.AbstractActionManager - 
Failed to execute action.
com.tibco.governance.pa.action.security.SecurityException: 
Policy enforcement failed to authenticate the request.
Caused by: com.tibco.trinity.runtime.core.provider.authn.LoginError:
Internal error in login; check logs java.lang.NullPointerException.
at com.tibco.trinity.runtime.core.provider.authn.AbstractLoginModule.
login(AbstractLoginModule.java:190)

With this fix, users can successfully invoke SOAP services secured via
Authentication policy using SSL-enabled LDAP Authentication.

PER-2188 In TIBCO ActiveMatrix BPM setup when a Load Balancer is used, the "X-Forwarded-
For" header is not being logged for successful as well as failed authentication login
attempts. With this fix, the "X-Forwarded-For" header will be logged for all
authentication attempts so as to identify the originating client's IP address when
attempting to connect to the server via HTTP proxy or a load balancer.

NOTE: The loggers com.tibco.amx.login.success and
com.tibco.amx.login.failure must be set to "INFO" level for the BPMNode in
order to view the log entries. This can be set using the Administrator UI >
Infrastructure > Nodes > Select Node > Configuration > Logging screen.

Once configured correctly, the log entries can be viewed in

<TIBCO_CONFIG_HOME>/tibcohost/<TH_INSTANCE_FOLDER>/data_3.2.x/nodes/

<BPM_NODE_NAME>/logs/BPMNode.log.

14

TIBCO ActiveMatrix® Service Grid Release Notes



Key Summary

SDS-7821 In TIBCO ActiveMatrix BPM, TIBCO Business Studio is not able to generate a script
for BPM projects from a Deploy Project due to NullPointerException.

The issue has been fixed and scripts are getting generated for BPM projects without
NPE in logs.

TAP-16366 TIBCO ActiveMatrix Administrator Node JVM property value does not support
special characters $, due to which installation of Node fails.

With this fix, the user can add special characters $ in the Node JVM property value
and Installation of a Node is also successful.

TAP-16338 In TIBCO ActiveMatrix Administrator GUI mode, when trying to change a resource
instance for an application using Resource picker dialog, unable to see Node level
resource instances when Tibcohost level is selected. With this fix, the resource picker
will drill down to Node level to show the list of resource instances the same as that
of TIBCO Host level.

TAP-16326 When trying to use ActiveMatrix Administrator exported data to populate the
rest_binding_data.xml file and then using CLI scripts ant -f
rest_binding_build.xml to edit the REST reference binding (Example: changing a
shared resource) of an application, the CLI build fails with the following error:
Type 'T=HttpTransportDetailsForReference@xxx' is not derived from 
'T=HttpTransportDetailsForRestReference@yyy' in element Binding

This is because ActiveMatrix Administrator export wizard does not handle REST
Reference binding properly.

With this fix, the exported app information has the correct tag name for the REST
reference binding in the data XML file, thus CLI build of editing the REST reference
binding does not fail with the preceding error.

TAP-16294 In a TIBCO ActiveMatrix BPM setup, when you change the logging levels of any
loggers in the amx.bpm.app application and apply the changes, it takes long time for
the changes to be applied in TIBCO ActiveMatrix Administrator. It takes even longer
to propagate the changes across all the Nodes on which the Application is deployed.

With the performance improvements that have been introduced as part of this fix,
the time taken to apply the changes to logger levels of the amx.bpm.app application
has been reduced to a fraction of the time it used to take before.

TAP-16292 In case of Node creation in TIBCO ActiveMatrix BPM, when computing capability
resolution for across Node dependencies, the old versions of the Application
Components are not being factored in. As a result, failures are seen during BPM
Node creation related to deployment of BPM User Applications.

With this fix, the BPM User Applications can be deployed and the BPM Node can be
created successfully.

TAP-16291 In a TIBCO ActiveMatrix BPM setup, in case of BPM Applications containing
multiple Component References promoted to the same Promoted Reference with
REST Binding, the Binding does not start successfully on newly created BPM Nodes.

With this fix, the REST Reference Binding starts successfully on newly created BPM
Nodes.
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Key Summary

TAP-16290 In TIBCO ActiveMatrix Administrator UI and CLI, invalid passwords are not
handled correctly for certain Resource Templates. These issues have now been
addressed.

TAP-16240 In certain TIBCO ActiveMatrix BPM setups, the list of all Applications on the
Applications tab takes a long time to load.

With this fix, the time taken to load the Applications tab has been reduced
significantly.

TAP-16279 In TIBCO ActiveMatrix Administrator, if user enables org.eclipse.jetty logger at
TRACE level on a node then there might be few "NoSuchMethodException" and
"NoSuchFieldException" exception at trace level. These exceptions are benign and
can be ignored.

TAP-16278

TAP-15948
In TIBCO ActiveMatrix BPM setup, when upgrading a BPM Application,
Administrator sets the "Prepare For Undeploy (PFU)" flag to "true" for the
components' old versions. Previously, Administrator sets the PFU flag back to "false"
if "UNCONFIGURE" task got canceled or failed during upgrade, thus blocking
further upgrade.

With this fix, Administrator doesn't set the PFU flag back to "false" even if
"UNCONFIGURE" task fails or cancels, allowing the application upgrade to proceed
successfully.

TAP-16219 In TIBCO ActiveMatrix BPM setup, making any change to application level logging
configuration during (in the middle of) BPM application update causes the
application update to fail.

With the fix, BPM application can be upgraded and deployed successfully though
application level logging is configured in the middle of application update.

TAP-16025 In TIBCO ActiveMatrix setup containing Nodes, which are in "Not Installed" state,
when JDBC drivers are updated using Administrator Command Line Interface (CLI)
"updateJDBCDriver" target, the reprovisioning and subsequent restarting of such
Nodes previously failed with a NullPointerException.

With this fix, the reprovisioning task will now skip such Nodes (that is, Nodes in
"Not Installed" state) when executing the "updateJDBCDriver" target, and an
informative message is provided indicating the name(s) of the skipped Node(s), as
follows:
[AMXAdminTask] INFO - TIBCO-AMX-CLI-000970: Nodes '<NodeName> 
(internal id:
 'NNN')'
are not installed yet, JDBC Driver installation has been skipped.

TAP-16007 Following an upgrade of the underlying jQuery library (used extensively by TIBCO
ActiveMatrix Administrator UI) in ActiveMatrix Service Grid 3.4.0, the latest version
of Microsoft Internet Explorer (IE 11), fails to load the Administrator. The issue is
due to the security constraints introduced in IE 11 which are incompatible with the
jQuery version used in 3.4.0.

This has now been addressed by changing the jQuery library to a version compatible
with IE 11. With this fix, Administrator UI loads as expected on IE 11.
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Key Summary

TAP-15999 During TIBCO ActiveMatrix BPM upgrade, the execution of the TCT CLI scripts fails
due to NullPointerException. This is due to the fact that the permission is created
without a parent object, and is thus inaccessible during the permission check
operation.

With this fix, for permissions created without a parent object, there will be no failure;
Administrator will log this in the SystemNode.log and proceed with the execution of
the stop command as expected.

TAP-15949 If a runtime Node installation fails for any reason, then any subsequent attempt to
install the Node again fails as the Platform Application already exists in the Node,
and as a result the following error occurs:
"Error invoking bulk action install on Node: TIBCO-AMX -
ADMIN-012368: The application key already exists!".

With the fix, the Node installation retry attempt first removes the existing Platform
Application, due to which the Node's installation completes successfully.

TAP-15948 In TIBCO ActiveMatrix BPM setup when upgrading a BPM Application,
Administrator sets the "Prepare For Undeploy (PFU)" flag to "true" for the
components' old versions. Administrator sets the PFU flag back to "false" if
"UNCONFIGURE" task fails during upgrade, thus blocking further upgrade. With
this fix, Administrator doesn't set the PFU flag back to "false" even if
"UNCONFIGURE" task fails, thus allowing further Application upgrade to proceed
successfully.

TAP-15946 In TIBCO ActiveMatrix SOA setup (not involving TIBCO ActiveMatrix BPM) when
upgrading an SOA Application, Administrator uses the "Prepare For Undeploy
(PFU)" mode to remove the old components, which is not needed for SOA
Application components. As a result, Administrator fails to remove the old
component, which is in START_FAILED state, from runtime.

With this fix, the PFU mode is no longer used to remove the old component, which
even in START_FAILED state, can be removed successfully from both Administrator
and runtime.

TAP-15942 In TIBCO ActiveMatrix SOAP/JMS Binding Type (BT) or JMS Binding Type (BT), the
underlying JMS Connection Factory Resource Instance (RI) intermittently fails to
start upon Runtime Node or TIBCO Host restart, when Authentication is enabled on
the JMS Connection Factory Resource Template (RT), and the JNDI Connection
Configuration RT name is a substring of the JMS Connection Factory RT name.

This issue has now been fixed and there will be no start failure for newly created
JNDI Connection Configuration and JMS Connection Factory Resource Instances.

NOTE: For the fix to take effect, all affected Resource Templates and their respective
Resource Instances must be removed, re-created, and reinstalled.

TAP-15908 jQuery version used by TIBCO ActiveMatrix has now been upgraded to 3.3.1.
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Key Summary

TAP-14926 The 'source' information for user actions is not displayed in SystemNode logs.

With this fix, IP, Host and time(UTC zone) printed in admin-user-action.log in
the needed format.

For more information, see "Displaying Source Information in Logs for User Actions"
topic in TIBCO ActiveMatrix® Service Grid Administration.
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Known Issues

The table lists known issues in this release of TIBCO ActiveMatrix Service Grid.

Key Summary

AMRP-5628 Summary: The node status does not include custom features during the sequential
checks when determining node health.

Workaround: None

AMRP-5445 Summary: If a Node Start action has been performed and the messaging bundle is
found to be in a Stopped state, the ActiveMatrix Administrator CLI stops
responding as the EMS messaging bundle is not loaded in the OSGi. This happens
due to a limitation in the ActiveMatrix platform.

Workaround: Reinstall the node.

AMRP-5043 Summary: The timeout value of a promoted service or a component service is not
updated when a promoted service or a component service is promoted.

Workaround: Specify the timeout value using the application-level property. For
example, if the name of an application is weatherApp, the following property can be
specified for the promoted service or component service that is promoted:
java.property.weatherApp.invocationTimeoutInMilliseconds.

For example, the following property sets the timeout value to 2 minutes:

java.property.weatherApp.invocationTimeoutInMilliseconds=12000

AMRP-4754 Summary: If a service provider and a service consumer exist in the same BPM
application, undeploying the application might undeploy the service provider even
though the service consumer still requires the service provider.

Workaround: Separate the service consumer and the service provider so that they’re
both in two separate user applications.

AMRP-4736 Summary: You might not be able to start TIBCO® BPM Enterprise as a Windows
Service after upgrading to ActiveMatrix release 3.3.0 from release 3.1.5 (or previous
releases) or TIBCO® BPM Enterprise release 2.2.0 from release 2.1.0 (or previous
releases).

Workaround: If you encounter this issue:

1. Launch a command prompt where tibcohost.exe is located.

2. Uninstall existing TIBCO® BPM Enterprise windows service by executing:
tibcohost.exe --uninstall

3. Install the windows service again by executing:
tibcohost.exe --install
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Key Summary

AMRP-4013 Summary: Acceptor threads for HTTP connectors might consume excessive
amounts of CPU. The processing performance of any node that uses an HTTP
connector experiencing this issue might be affected when asynchronous IO is
involved.

Workaround: Edit the HTTP Connector resource template to use blocking IO. For
more information, see the section "Managing Resource Templates" in TIBCO
ActiveMatrix Service Grid Administration.

AMRP-3788 Summary: The LDAP resource template pool properties are not used when
initializing the connection pool.

Workaround: Configuring the connection pool using system properties specified for
the target node applies them to all instances deployed to that node.

Refer to the Oracle documentation for more information: http://docs.oracle.com/
javase/jndi/tutorial/ldap/connect/config.html.

AMX-18646 Summary: The following upgrade path fails:

Upgrade from ActiveMatrix Service Grid 3.1.5 to version 3.3.0 by using scripts. Then
upgrade from version 3.3.0 to version 3.4.0. Then upgrade from version 3.4.0 to
version 3.4.1.

Workaround:

● Before upgrading to ActiveMatrix Service Grid 3.4.1, update
java.heap.size.max=512M to java.heap.size.max=1024M in the
<TIBCO_HOME>/amx/3.4/bin/nodeutil.tra file.

● After performing preceding step, upgrade to version 3.4.1 is successful but some
runtime host fails during start after upgrade and the
com.tibco.amx.platform.artifactserver application in the
SystemEnvironment is in the Start failed state. In this case, manually start Host
and Nodes OR undeploy and deploy the
com.tibco.amx.platform.artifactserver application.

AMX-18583

AMX-18539

Summary: After upgrading from an earlier version with ActiveMatrix Policy
Director Governance installed to ActiveMatrix Service Grid 3.4.1, the ActiveMatrix
Policy Director Governance application version is not displayed correctly in the
Administrator UI.

Workaround: None. This issue does not have a functional impact; everything works
as expected.

AMX-18554 Summary: Downgrading from ActiveMatrix Service Grid 3.4.1 to an earlier version
by using TIBCO Configuration Tool in the silent mode fails with the following error:
java.lang.RuntimeException: XPathFactory#newInstance() failed to 
create an XPathFactory for the default object model: http://
java.sun.com/jaxp/xpath/dom with the 
XPathFactoryConfigurationException: 
javax.xml.xpath.XPathFactoryConfigurationException: 
java.util.ServiceConfigurationError: javax.xml.xpath.XPathFactory:

Workaround: None
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Key Summary

AMX-18536 Summary: TIBCO ActiveMatrix BusinessWorks™ Service Engine application
deployment fails after upgrade to ActiveMatrix Service Grid 3.4.1.

Workaround: None

AMX-18474 Summary: When invoking SSL enabled SOAP service which refers to the keystore
file with DH keysize <1024k, the following error occurs:
javax.net.ssl.SSLHandshakeException: DH ServerKeyExchange does not 
comply to algorithm constraints

Workaround: Update your keystore to use the DH keysize larger than 1024.

OR
Edit tibcojre64/1.8.0/lib/security/java.security file and add the desired
length to the jdk.tls.disabledAlgorithms property by appending DH KeySize <
min keylength :
jdk.tls.disabledAlgorithms=SSLv3, TLSv1, TLSv1.1, RC4, DES, 
MD5withRSA, \
DH keySize < 768

AMX-18365 Summary: When secure SystemHost and RemoteHosts (Host for which JMX port is
secured) are successfully upgraded to ActiveMatrix Service Grid 3.4.1, the
Administrator UI does not show the updated version of hosts correctly.

Workaround: When the hosts are secured, SystemNode is configured with TLSv1,
which is the supported TLS in versions of ActiveMatrix Service Grid prior to 3.4.0.
Starting from ActiveMatrix Service Grid 3.4.0 and later, TLSv1.2 is supported, and
all the Hosts are updated to automatically use TLSv1.2 when upgraded to 3.4.1,
except the Administrator (SystemNode).

When you encounter this issue, run the following command after upgrading to
ActiveMatrix Service Grid 3.4.1 to update Administrator (SystemNode) to support
TLSv1.2.

Navigate to <TIBCO_HOME>/amx/3.4/bin folder and execute the following
command:
tibamx_hostmanager updateAdminToTLSv12 -configHomeLocation 
<TIBCO_CONFIG_HOME>

● Hosts and Nodes MUST be stopped before running the above
command. After running the command, restart Administrator
(SystemNode).

● The preceding command must be executed only on the machine where
SystemNode and SystemNodeReplica (if applicable) is running.

AMX-17606 Summary: If you have upgraded from an earlier version of TIBCO ActiveMatrix
Service Grid including hotfixes to TIBCO ActiveMatrix Service Grid 3.4.0, when you
downgrade from TIBCO ActiveMatrix Service 3.4.0 to the earlier version, you cannot
revert the hotfixes applied earlier using revertPatch command.

Workaround: None
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Key Summary

AMX-17411 Summary: When the java.property.com.tibco.amx.decouple.Manual.Nodes
property is set to true in the TRA file, the SystemHost is downgraded but the
SystemNode fails to downgrade.

Workaround:

1. Set the following property:
java.property.com.tibco.amx.decouple.Manual.Nodes=false

2. Restart ActiveMatrix Administrator.

3. Upgrade SystemHost to 3.4.0 and downgrade again.

AMX-17409 Summary: Consider that an ActiveMatrix Administrator server is upgraded to 3.4.0
from a prior version and this server is downgraded with a wrong ActiveMatrix
Administrator port. In this case, if you do not test the connection to the ActiveMatrix
Administrator server before the downgrade, the TIBCO Configuration Tool
downgrade process hangs when checking ActiveMatrix Administrator initialization
at the "Checking for Admin initialization..." step.

Workaround: Kill the TIBCO Configuration Tool and provide correct information
for ActiveMatrix Administrator configuration. For example, port, SSL information,
and so on. Run the downgrade wizard again.

AMX-17393 Summary: When SAML Single Sign On configuration is enabled, if you delete the
browser cookies, after re-directing from error page to landing page, you are not
prompted for login credentials.

Workaround: Logout from the previous browser session.

AMX-17365 Summary: After upgrading to ActiveMatrix 3.4.0, the ActiveMatrix 3.3.0 Hotfix<x>
runtime host fails to be downgraded back with the following error:
product feature 
com.tibco.amf.sharedresource.extensions.runtime.tibcohost.product.fea
ture 3.3.xx.000 contains a release unit 
com.tibco.amf.hpa.core.runtime.services.feature 1.5.0.003 that does 
not exist in the machine model

Workaround: Always select the Mediation Runtime option while installing the
Runtime Host profile for the remote hosts.

AMX-17351 Summary: Even after downgrading from 3.4.0 to a lower version and uninstalling
3.4.0, the Configure TIBCO Service Performance Manager - V2.3 option is available
in the TIBCO Configuration Tool. If you click the option, a Null Pointer exception is
thrown.

Workaround: None. Do not click the Configure TIBCO Service Performance
Manager - V2.3 option.

AMX-17343 Summary: If one of the EMS servers fails on an Amazon Web Services (AWS) setup,
the status of some nodes is shown as LOST_Contact.

Workaround: Reconnect the EMS connections by clicking Admin Configuration >
Admin Server > Transport Configuration tab > Administrator Reconnect. After the
reconnection, all the entities are shown as online.

22

TIBCO ActiveMatrix® Service Grid Release Notes



Key Summary

AMX-17323 Summary: The TIBCO ActiveMatrix Governance Agent for TIBCO
BusinessWorks Notification screen of the Create TIBCO ActiveMatrix Policy
Director Administrator Server - V3.4 wizard is removed in 3.4.0. However, some
shared resources related to this screen (EMS ConnectionFactory, JMS Destination,
JNDI Connection) are created in ActiveMatrix Administrator. These shared
resources are added as an application property and can be viewed from the
ActiveMatrix Administrator UI:

● Application name: com.tibco.ampd.ogp.de

● Properties: bwJmsSharedResource and bwAgentAdapterJmsDestination

Workaround: The shared resources created by the screen are not used. You can
ignore them.

AMX-17316 Summary: After the uninstallation of ActiveMatrix Service Grid 3.4.0, some files and
folders are not removed from TIBCO_HOME. For example, the
tibamx_hostmanager.properties file from the TIBCO_HOME/amx/3.4/scripts
and TIBCO_HOME/tct/1.6 directories are not removed.

Workaround: None

AMX-17226 Summary: On IBM AIX, if the Deploy Log Service option is selected and you create
the ActiveMatrix Administrator server, the following error is displayed:
Error Loading Extension Registry error

Workaround: Clear the Deploy Log Service option when creating the ActiveMatrix
Administrator server.

AMX-17182 Summary: In the TIBCO Configuration Tool, host names or DNS names cannot have
underscores in their names. As a result, TIBCO Configuration Tool fails if the name
of the Available Group Listener contains underscores while configuring the
AlwaysOn Database Setup in SQL Server 2017.

Workaround: Do not use underscores in the name of the Available Group Listener
while configuring the AlwaysOn Database Setup on SQL Server 2017.

AMX-17144 Summary: On Microsoft Windows, when you try to update JRE by using TIBCO
Configuration Tool, occasionally the following error occurs:
Caused by: TIBCO-AMX-TOOLS-JREUPDATER-000048: Cannot write to the 
file. E:\AMX_v43\amx\3.4\scripts\rpflauncher_classpath_3.4.0.tra.

Workaround: Run the command two or three times until it succeeds.

AMX-17120 Summary: Occasionally, because of manual intervention or execution of certain
scripts, the network time of the machine where Active Directory Federation Services
(ADFS) or WebApp is hosted might be out of sync and result in authentication
failure for response being too old or from future.

Workaround: The network time of the machine must be synchronized. For Linux,
the synchronization must happen with the Network Time Protocol server. For
Windows, use the Windows time service. There are standard operating system level
procedures for synchronizing the machine network time.
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Key Summary

AMX-16828 Summary: If you invoke a REST service binding with an OpenID Policy through a
SOAP client such as SoapUI, it always sends an Access Token, which is an opaque
token. Access Tokens are not currently supported.

Workaround: Use the ID Token (which is a JWT token) generated by the Access
Token URI to send the request in SoapUI.

AMX-16800 Summary: On a replication setup, when upgrading from 3.3.0 to 3.4.0, the primary
ActiveMatrix Administrator server does not start correctly after a successful
upgrade.

Workaround: Restart the ActiveMatrix Administrator server.

AMX-16672 Summary: Double downgrade is not supported. For example, downgrading from
3.4.0 to 3.3.1 to 3.3.0 fails with the following errors:
TIBCO-AMX-CLI-000944: Failed to downgrade TIBCO Host instance(s).
TIBCO-AMX-CLI-000942: Downgrade TIBCO Host instance <instance name> 
is not possible.

Workaround: None

AMX-16634 Summary: For an upgraded TIBCO host, the tibcohost describeHost command
incorrectly shows the upgrade status as None.

Workaround: None

AMX-16542 Summary: After upgrading TIBCO Business Studio to TIBCO ActiveMatrix 3.4.0, it
is no longer supported on the macOS operating system.

Workaround: None

AMX-16505 Summary: On a replicated setup, if one of the servers is downgraded, the version of
the TIBCO ActiveMatrix REST BT Administrator Plug-in shows as 3.4.0 instead of
showing the older version.

Workaround: None

AMX-16084 Summary: The Service Performance Manager (SPM) dashboard does not work with
EMS fault tolerance mode.

Workaround: None

AMX-16083 Summary: If a Java project has errors (faults) configured in RRC and has execution
environment as JAVASE-1.6 or lower, DAA generation fails.

Workaround: To generate the DAA file, make sure that the
RequiredExecutionEnvironment field in the Manifest.MF file is empty. It allows
you to create the DAA and deploy it at run time.
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Key Summary

AMX-16017 Summary: When 3.4.0 is installed over 3.3.0 with Hotfix 17 applied to it, if all the
check boxes (3.3.0, Hotfix 17, and 3.4.0) are selected in the Custom Uninstall dialog
box, the following error is displayed during the TIBCO ActiveMatrix SPM
Dashboard uninstallation:
ANT Task: TIBCO ActiveMatrix Pre-Uninstallation - ActiveMatrix SPM 
Dashboard has failed.

Workaround: Uninstall the products in the following order:

1. 3.4.0

2. 3.3.0 Hotfix 17

3. 3.3.0

AMX-16016 Summary: Downgrading SystemHost from ActiveMatrix 3.4.0 to an earlier version
fails if the CONFIG_HOME where the SystemHost is present contains other runtime
hosts that are bound to a different ActiveMatrix Administrator server instead of the
ActiveMatrix Administrator server from the selected CONFIG_HOME.

Workaround: Ensure that all the runtime hosts that are in the selected CONFIG_HOME
must be bound to the ActiveMatrix Administrator Server from the same
CONFIG_HOME.

AMX-15975 Summary: Even when the command line interface is used, the notification transport
update fails with the following error message:
TIBCO-AMX-ADMIN-021085: Failed to update the notification 
transport!, Caused by:
TIBCO-AMX-ADMIN-021281: The number of hosts in this enterprise is 
more than 10. 
Please use the Administrator Command Line Interface for updating the 
Notification Transport.

Workaround: None

AMX-15840 Summary: After upgrading from 3.2.0 to 3.4.0, the Mediation application template
shows version as 3.4.0.007 instead of 3.5.0.007.

Workaround: None

AMX-15806 Summary: When a DAA created in 3.3.0 with javax.servlet is run as a composite
application in 3.4.0 (Deployment Artifacts > right-click the DAA file > Debug As >
Composite application), RAD starts, but fails with Provisioning Node errors.

Workaround: Re-create the DAA in 3.4.0.

AMX-15775 Summary: In 3.4.0, an HTTP connector is created as non-blocking by default. That is,
the Use Non-Blocking IO Sockets check box on the Advanced tab is selected by
default. When this check box is selected, the Acceptor Threads field on the General
tab is disabled and 1 is used as the default number of Acceptor Threads.

For an internal HTTP connector, if the Use Non-Blocking IO Sockets check box is
cleared and a value greater than 1 is specified in the Acceptor Threads field, all
except one of the acceptor threads is in a blocked state.

Workaround: Keep the Use Non-Blocking IO Sockets check box on the Advanced
tab cleared.
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Key Summary

AMX-15756 Summary: During installation using the GUI mode, a name cannot be specified for
the installation environment.

Workaround: Install using the Silent installation mode if you want to specify an
environment name.

AMX-15614 Summary: When creating an ActiveMatrix Administrator server by using TIBCO
Configuration Tool, if the Oracle user name has quotes (“ ”) and hyphen (-), TIBCO
Configuration Tool fails to create the ActiveMatrix Administrator server and returns
the following error:
Caused by: java.sql.SQLSyntaxErrorException: ORA-00942: table or 
view does not exist

Workaround: Avoid using quotes (“ ”) and hyphen (-) in the user name.

AMX-15569 Summary: The -ignoreNodeStartupMode argument of the Host Manager's
startAllHosts command does not work for a Microsoft Windows NT host. For a
Microsoft Windows NT host, it starts a node configured for automatic startup but
does not start a node configured for manual startup.

Workaround: Start Microsoft Windows NT host or service manually.

AMX-15379 Summary: If application App1 with promoted service Service1 containing a SOAP/
HTTP binding Binding1 is deployed in environment Env1, and another application
App1 with promoted service Service1 containing a SOAP/JMS binding Binding1 is
deployed in environment Env2, the TIBCO ActiveMatrix SPM dashboard shows an
incorrect binding type for the application App1 deployed in Env2. That is, the
dashboard shows the binding type as SOAP/HTTP instead of SOAP/JMS. This issue
applies to promoted references as well. Additionally, it applies to all binding types -
SOAP/HTTP, SOAP/JMS, and JMS.

Workaround: None
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Key Summary

AMX-15261 Summary: On a machine which has a TIBCO ActiveMatrix 3.3.0 Hotfix installed,
while upgrading to TIBCO® BPM Enterprise 4.0.0, the TIBCO ActiveMatrix version
is downgraded if all the following options are selected:

● Upgrade ActiveMatrix TIBCO Host Instance
● Upgrade ActiveMatrix Administrator
● Upgrade Nodes Hosting TIBCO® BPM Enterprise Instance
● Upgrade TIBCO® BPM Enterprise Instance Application [Upgrading Database]

Workaround:

1. Stop tibcohost.

2. Apply the TIBCO ActiveMatrix 3.3.0 Hotfix again by running the patch manager.

3. Start tibcohost.

4. From ActiveMatrix Administrator, check systemnode and bpmnode. The
expected hotfix version is displayed.

5. Launch TIBCO Configuration Tool to upgrade to TIBCO® BPM Enterprise 4.0.0.
Select the last two options:

Upgrade Nodes Hosting TIBCO® BPM Enterprise Instance

Upgrade TIBCO® BPM Enterprise Instance Application [Upgrading Database]

AMX-13851 Summary: If you use Microsoft SQL Server 2012 as an external database server and
use its Mirror Mode to establish a connection to a secondary failover database
server, TIBCO ActiveMatrix Administrator fails to connect to either database server.

Workaround In addition to providing the JDBC URL of the mirrored servers in SQL
Server 2012, you must set the IP and hostname of both the primary and secondary
database servers in the hosts file. The location of the hosts file depends on the
operating system:

● Windows: ROOT_DIR\system32\drivers\etc\hosts

● UNIX/Linux: /etc/hosts

For example, you have two database servers. The primary server's IP is 192.167.71.42
and its hostname is amx-db42; the secondary server's IP is 192.167.71.60 and its
hostname is amx-db60. You would provide the following JDBC URL for these two
mirrored primary and secondary servers:
jdbc:sqlserver://
192.167.71.42:1433;databaseName=db1;failoverPartner=192.167.71.60

To ensure that ActiveMatrix Administrator successfully connects to both servers and
allows for seamless switching between them using SQL statements, you must add
the following entries to the hosts file:
192.167.71.42 amx-db42
192.167.71.60 amx-db60
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Key Summary

AMX-11970 Summary: In a replicated ActiveMatrix Administrator server setup, if you deploy to
the system node applications with policies applied on them, the policies are not
enforced after upgrade.

Workaround: First undeploy and then redeploy these applications after upgrading
all system nodes.

BJMS-1490 Summary: JNDI Resource Template using Custom Property for LDAP Provider URL
will not get installed.

Workaround: Provide URL in the Provider URL field on the Resource Template.

BJMS-1382 Summary: If JMS Binding configured with JMS At Least Once Policy is undeployed
before the redelivery count is exhausted, and deployed again, the message is not
redelivered.

Workaround: None

BJMS-1374 Summary: If JMS Binding is configured with JMS At Least Once Policy and the EMS
Provider URL used for connection is fault tolerant, the message is not redelivered in
case EMS crashes.

Workaround: None

BJMS-755 Summary: Enterprise Message Service XA Resources from orphaned transactions do
not disappear after transaction timeout from Enterprise Message Service server.
They are seen on the Enterprise Message Service server as a part of show
transactions command.

Workaround: Re-start the Enterprise Message Service server. As there is no locking
in messaging associated with an XA resource, this issue is not serious.

BJMS-736 Summary: When a 2.x project containing a JMS binding is migrated to 3.x, the JNDI
resource templates required for looking up the destination are not created and the
generated warning does not clearly state that JNDI resource templates need to be
created.

Workaround: Manually create JNDI resource templates required for defining
inbound and outbound destination configurations.

BJMS-726 Summary: On re-starting Enterprise Message Service, for in-flight messages,
transaction does not get committed. Re-delivery happens and message is forwarded
to the error queue.

Workaround: Recover the requests from the error queue.

BJMS-718 Summary: For JMS binding, the SDS UI allows you to set Context Parameters of
type Message. This is not supported for JMS Binding.

Workaround: Do not use type Message for Context Provisioning related to JMS
Binding.

BJMS-636 Summary: The show connection command in the TIBCO Enterprise Message Service
administration tool ems-admin does not contain "ClientID" value for connections
created by JMS resource instances for outbound connections.

Workaround: None
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Key Summary

BJMS-603 Summary: ActiveMatrix Administrator does not validate that an application with
JMS Transacted One-Way policy set should be deployed on a single node.

Workaround: Ensure that the JMS binding that has a JMS Transacted One-Way
Policy is deployed on the same node as that of component(s), it is wired to.

BJMS-355 Summary: When a JMS service is deployed in LB setup over routed queues, the
following message is displayed and the service does not start:
javax.jms.IllegalStateException: Not allowed to use transacted 
session on routed queues

Workaround: Enterprise Message Service does not support transactions on routed
queue consumers. Enterprise Message Service 6.0 added an explicit check to prevent
this. You can restore the old behavior by setting the following configuration
parameter:

allow_unsupported_tx_routed_q_consumers = true

BJMS-139 Summary: If you rename an operation in a WSDL file, JMS bindings on composite
services and references are not updated correctly.

Workaround: Create new JMS binding after renaming the WSDL operation or re-
assign the WSDL file to existing JMS binding.

DSS-982 Summary: Changing or updating the TIBCO Credential Server (TCS) certificate
results in host security failure.

Workaround: None

DSS-813 Summary: While upgrading to ActiveMatrix release 3.3.0, you might see benign
errors similar to the following example:
[ERROR]com.tibco.trinity.runtime.base.provider.identity.CipherSupport

Workaround: Such errors are harmless and do not mean that the upgrade failed. No
action is required.

HKAM-411 Summary: On the Solaris operating system, the AMXNode microagents are not
shown in the Hawk Display.

Workaround: None

HKAM-402 Summary: After upgrading ActiveMatrix 3.3.0 to ActiveMatrix 3.4.0, when you call
the getConfig method, the Monitoring Application State is shown as NOT
CONFIGURED.

Workaround: Before upgrading to ActiveMatrix 3.4.0, apply ActiveMatrix 3.3.0
Hotfix 10 or higher.
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HKAM-397 Summary: When Hawk ActiveMatrix Plug-in (HKAM) is used for large scale
systems, tibhawkagent stops automatically with the following error
RV: DrainQueue: out of memory.

Workaround: If HKAM is configured with more than 10 hosts, increase memory of
tibhawkagent.

To change memory of tibhawkagent:

1. Open tibhawkagent.tra located at <hawk.config.home>/tibco/cfgmgmt/
hawk/bin.

2. Change values of -XX:MaxPermSize, java.heap.size.initial and
java.heap.size.max based on number of hosts.

For 60 hosts, the following values are recommended:

● java.heap.size.max = 4 GB

● -XX:MaxPermSize = 1 GB

HKAM-389 Summary: After a Notification Transport Server Configuration update, the
TIBCOHost's HKAM rulebases point to the previous Notification Transport Server
Configuration.

Workaround: After a Notification Transport Server Configuration update, you must
manually update the TIBCOHost's HKAM rulebases.

HKAM-384 Summary: When HKAM is configured on a large scale setup, invoking a method on
a Host microagent fails with a timeout.

Workaround: Change the default HKAM rulebase for host and node. Make it event-
driven rather than polling at a fixed interval.

HKAM-374 Summary: On Windows Server 2008 R2, if a node belongs to a host created with a
Windows NT service, invocation of the following methods on the node microagent
fails with a StatsDataAdapter is null error:

● changeMonitoringConfig

● getBindingOperationStats

● getComponentOperationStats

● getConfig

Workaround: None
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HKAM-373 Summary: When QIN update is performed on a host which is already configured
with HKAM, the EMS related information in the hawkems<host_name>.hma file
points to the old notification server.

Workaround: Change the EMS values for -user, -encryptedPassword, and -
server of the new notification server manually in the hawkems-<host_name>.hma
file.
<arg>-user</arg>
<arg>${new_username}</arg>
<arg>-encryptedPassword</arg>
<arg>${new_password}</arg>                 
<arg>-server</arg>
<arg>${new_notification_server_url}</arg>

HKAM-343 Summary: On Solaris, hawk.log shows the following error and method invocation
for CLEventPublisherMicroAgent does not return any data:
Error loading microagent from 
com.tibco.hawk.microagent.commonlogging.publisher.CLEventPublisherMic
roAgent: java.lang.IllegalArgumentException

Workaround: None

HKAM-337 Summary: For a node, you cannot view statistics for a WebApp component using
the onComponentOperationStats Hawk method.

Workaround: None

HKAM-336 Summary: For a node, you cannot view statistics for a WebApp component using
the getComponentOperationStats Hawk method.

Workaround: None

HKAM-266 Summary: If the ActiveMatrix Administrator server or TibcoHost instance is
configured to use SSL-enabled Enterprise Message Service on AIX platform, and
Hawk 5.0 is installed, then starting Hawk Agent fails with an error.

Workaround: Use Hawk 4.9 instead of Hawk 5.0.

HKAM-264 Summary: You cannot change the timeout of method invocation for Custom
microagent.

Workaround: None

HKAM-253 Summary: Hawk Display shows multiple entries for node Service microagent when
rulebases for TibcoHost or nodes are invoked after the TibcoHost or node crash.

Workaround: Click Done, and open the microagent again. Alternatively, restart
Hawk Display.

HKAM-251 Summary: Continuous error messages are seen in the hawk.log file after starting
tibhawkagent.exe on HAWK 5.0. Hawk 5.0 is unable to run powershell.exe used
in TibcoHost rulebase.

Workaround: Prefix powershell.exe in the rulebase of the TibcoHost with the
absolute path of powershell.exe.
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HKAM-250 Summary: When using Hawk 5.0, logs are not generated in the CONFIG_HOME/hkam/
<host_instance_name>/logs folder. The Hawk Agent shows errors related to
slf4j in the Hawk logs.

Workaround: Remove the slf4j jars and jars with different versions of slf4j from
the agent classpath.

HKAM-249 Summary: The Stop Reason and Reason Code arguments are not updated for the
onNodeEvent method after calling stopNode.

Workaround: None

HKAM-242 Summary: Hawk 5.0 cannot find Windows PowerShell.

Workaround: Prefix powershell.exe in the rulebase of the TibcoHost with the
absolute path of powershell.exe.

HKAM-237 Summary: On creating a node in the ActiveMatrix Administrator web interface, its
rulebase is created in the CONFIG_HOME/hkam/<host_instance_name>/rulebases
folder. If the node is deleted, the HAWK.log file continuously produces errors.

Workaround: Manually delete the rulebase to avoid error entries in the HAWK.log
file.

HKAM-193 Summary: Hawk ActiveMatrix Plug-in displays some ActiveMatrix applications or
components in runtime state as uninstalled, but ActiveMatrix Administrator or
nodeutil do not show these applications.

Workaround: Restart Hawk Agent to clear the cache.

IWAP-725 Summary: (TIBCO® BPM Enterprise only) If you change a substitution variable
(such as %%httpConnectorPort%%) from a hardcoded value (such as 443) or vice
versa in an HTTP connector resource template, Workspace and Openspace fail to
open and you might see an error similar to the following example in the logs:
[ERROR] com.tibco.n2.rtc.ap.ActionProcessor - [ERROR] - 
{WS_REQUEST_EXCEPTION} - Workspace caught an Exception 
¬{extendedMessage=`Invalid Security Context: Missing requested 
attribute

Workaround: Redeploy the application and restart Workspace and Openspace.

IWAP-669 Summary: If you add a WebApp component to an imported project created in
ActiveMatrix 3.2.0 that already has a WebApp component, every time you select the
newly added WebApp component after selecting the original WebApp component
the Thread Context Class Loader Type drop-down list in the Properties >
Implementations tab is disabled.

Workaround: Deselect the newly added WebApp component (by selecting any area
on the canvas that is not the original WebApp component from the imported
project), then select the newly added WebApp component again. The Thread
Context Class Loader Type drop-down list is enabled.

IWAP-223 Summary: In the web.xml file, resource-ref elements are not supported.

Workaround: None
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IWAP-72 Summary: The WebApp component does not have an option to modify the Web
Application connector during deployment in TIBCO Administrator UI.

Workaround: To configure or change the connector name in TIBCO ActiveMatrix
Administrator:

1. In TIBCO Business Studio, open the project containing the Web Application
component.

2. Promote the defaultConnector property to a composite level:

a. Select the defaultConnector property on the component.

b. Right-click and select Promote.

3. Make the composite property a substitution variable so it can be substituted in
TIBCO Administrator before deployment.

4. Right-click on composite and select Create DAA.

5. In ActiveMatrix Administrator, make sure a connector with the same name is
created in ActiveMatrix Administrator and deployed on to the node before the
Web Application DAA is deployed.

MCR-2002 Summary: If you have configured Microsoft SQL Server 2012 as a database for
Administrator, invoking a custom DAA might result in harmless exceptions similar
to the following examples:
Caused by: com.microsoft.sqlserver.jdbc.SQLServerException: 
Violation of UNIQUE KEY constraint 'UQ__Mcr2Stat__1C012A471DC5DDE4'.
Cannot insert duplicate key in object 'dbo.Mcr2StatisticsMetric'. 
The duplicate key value is (93, 21, 22, 3, -1).
at 
com.microsoft.sqlserver.jdbc.SQLServerException.makeFromDatabaseErro
r(SQLServerException.java:216)
at 
com.microsoft.sqlserver.jdbc.SQLServerStatement.getNextResult(SQLServ
erStatement.java:1515)
at 
com.microsoft.sqlserver.jdbc.SQLServerPreparedStatement.doExecutePrep
aredStatement 
SQLServerPreparedStatement.java:404)                     

Workaround: None

MCR-1995 Summary: If you have configured IBM DB2 as an external database, you might see
harmless exceptions similar to the following examples in SystemNode.log:
Retrying database transaction after error: Processing of metric 
requestsIn for event 
com.tibco.governance.amxserviceprobe.ServiceProbeInstruments.ServiceR
equestIn failed for measure Total and time window Since Started Time 
Window 
Retrying database transaction after error: Processing of metric 
faults for event 
com.tibco.governance.amxserviceprobe.ServiceProbeInstruments.ServiceE
xecutionTime failed for measure Total and time window Since Started 
Time Window     

Workaround: Such exceptions are benign and do not require any action.
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MCR-1943 Summary: If you have upgraded to ActiveMatrix release 3.3.0 from a prior version
and attempt to replicate the upgraded configuration, deploying the replicated
configuration might fail.

Workaround: Replicate your configuration before upgrading to ActiveMatrix release
3.3.0.

MCR-1823,

TAP-10602

Summary: The value for the uptime displayed in the infrastructure dashboard
screens are accounted from the time a request is made to the application by invoking
the endpoint or through an internal call from another application.

If an application is deployed and not used, the value for uptime is 0.

Workaround: None

MCR-1422 Summary: If nodes are restarted when the SystemNode is down, the Uptime and
Since Started statistics are not reset.

Workaround: Either make sure that the system node is running using admin
replication or restart the applications for which incorrect statistics are seen.

MCR-1350 Summary: The number of components reported for a given node in the Enterprise
Graphical View includes components that belong to the ActiveMatrix Platform
Application. The Dashboard component count does not include these components.

Workaround: None

MCR-1226 Summary: The Endpoint, Service, and References tabs display an incorrect value
for Avg Comp Process Time when extended monitoring is enabled. The value
displayed is Req Comp Time.

Workaround: The correct average component processing time is available in the
Components and Applications tabs.

MCR-1205 Summary: If the TibcoHost is shutdown while the dashboard is running, the
following error message is seen in the SystemNode log files:
[ERROR] org.apache.axis2.engine.AxisEngine - 
bean:name=govObjFilterServiceMBean

Workaround: None. This error can be safely ignored.

MCR-1204 Summary: Stopping the TibcoHost instance occasionally causes exceptions to be
thrown in the log file. During a graceful stop of TibcoHost instance there might be
some exceptions in the log file with the root cause. For example:
Caused by: java.lang.RuntimeException: Statistics aggregator is 
closing down, rolling back transaction

Workaround: Ignore the error.

MCR-1162 Summary: Statistics for Web Application components do not display in the
dashboard.

Workaround: None
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MCR-876 Summary: Status value is Unknown and uptime is empty when the same application
is deployed on two nodes across environments.

Workaround: Change the application name during deployment. The application
name must be unique for an enterprise. The dashboard shows the correct status and
uptime.

MCR-800 Summary: When a component reference is promoted, component reference metrics
show zero values. All metrics are shown on the promoted reference and reference
endpoint.

Workaround: View metrics on the promoted reference.

MCR-753 Summary: In the Dashboards > Infrastructure screens the application request count
includes requests counts from all services promoted to application level. In addition,
it incorrectly includes reference invocations count from all references promoted to
application level.

Workaround: None

MCR-521 Summary: If a node is stopped or started several times while SystemNode is down,
the last stop or start time of SystemNode is used to calculate the node’s uptime
percentage. Other stops and starts are missed and not used in uptime calculation.

Workaround: Configure the ActiveMatrix Administrator server in fault tolerant
mode.

MED-3306 Summary: SOA projects created by the AutoMediate Tool might fail to be deployed
by the tool if the projects have SOAP over JMS bindings.

Workaround: Re-create all JMS Connection Factory and Destination resources in
TIBCO Business Studio.

MED-2907,

MED-2885

Summary: The Mediation editor does not reload changes to the XSD unless the
project is restarted.

Workaround: To resolve this:

1. Import all projects into the workspace.

2. Restart TIBCO Business Studio.

3. Run Project > Clean > Clean all projects.

MED-2055 Summary: The Transform task does not handle the Byte Order Mark (BOM) in
external stylesheet files.

Workaround: Open the stylesheet in a text editor and save it manually in a format
without using BOM.

MED-1827 Summary: Deploying a mediation application that uses custom XPath functions and
if the custom XPath function plug-in is not deployed, results in errors at the time of
deployment.

Workaround: None
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MED-1739 Summary: When adding a PortType with many (about 50+) operations, the
validation begins before the mediation flow is fully updated. This causes error
markers to appear on the mediation operations when no actual problems exist.

Workaround: Select Project > Clear from the menu bar and the validation restarts.
The error markers disappear, unless there are actual problems that remain.

MED-1736 Summary: Dragging and dropping a WDSL into a mediation flow results in the
following error:
Receive Wrong Transfer data 

Workaround: None

MED-1703 Summary: Creating schema using the Create button creates the schema for CMT
model plugin wizard but does not set it.

Workaround: Once the schema is created, you can browse and select the schema in
the wizard to set it for both Input and Output Schemas in the plugin wizard.

MED-1652 Summary: The message type context property does not specify an unbound
message even though the selection list contains all message elements in the WSDL.
An unbound message is one that is not used for Input, Output, or Fault parts.

Workaround: Only select unbound message elements for context properties.

PD-4479

PD-4429

Summary: Even after successfully downgrading from 3.4.x (Example: 3.4.0 or 3.4.1)
to ActiveMatrix 3.3.0 (with Hotfix 23 and Policy Director Hotfix 02 installed), the
following plug-ins show 3.4.x as the version:

● TIBCO ActiveMatrix Operations Governance Platform Administrator plug-in

● TIBCO ActiveMatrix Administrator Governance Policy Director admin plug-in

Workaround: This issue does not have a functional impact; everything works as
expected.

PD-4435 Summary: When the Basic or User nameToken Authentication Governance Control
is enforced on the object group with a WebApp and REST binding member, the
policy does not work when used as User nameToken Authentication but works
when used as Basic Authentication.

Workaround: None

PD-4431 Summary: A policy is not enforced for an application if the application is deployed
before deploying the Policy Director Governance server.

Workaround: None

PD-4423 Summary: Logging policy is not supported by the ActiveMatrix Administrator
server (with ActiveMatrix Policy Director Governance services) of ActiveMatrix 3.4.0
when the server is configured with SSL-enabled Enterprise Message Service.

Workaround: None

36

TIBCO ActiveMatrix® Service Grid Release Notes



Key Summary

PD-4420 Summary: On the Governance tab of the ActiveMatrix Administrator UI, the
applications that have policies applied to them incorrectly show their undeployed
policies as Active.

Workaround: None

PD-4371 Summary: OpenID Connect authentication is not supported via Policy Director
Governance in this release. Consequently, the following operation in TIBCO
ActiveMatrix Administrator fails:

Governance > New > Authentication By OpenID

Workaround: None

37

TIBCO ActiveMatrix® Service Grid Release Notes



Key Summary

PER-1931 Summary: Nonce is not supported for messages sent from TIBCO ActiveMatrix
BusinessWorks to TIBCO® BPM Enterprise. Therefore, if you use TIBCO
ActiveMatrix BusinessWorks as a client to invoke an TIBCO® BPM Enterprise
process as service, you might see the following error:
PolicyEnforcement Failed to Authenticate the request.

Workaround: Modify the WSDL generated by ActiveMatrix to add the following
schema, WSDL message, and WSDL input in binding to successfully invoke an
TIBCO® BPM Enterprise service from TIBCO ActiveMatrix BusinessWorks.

Schema
<xsd:schema elementFormDefault="qualified" targetNamespace="http://
schemas.xmlsoap.org/ws/2002/07/secext">
<xsd:import namespace="http://schemas.xmlsoap.org/ws/2002/07/
utility"/>
<xsd:element name="Security" type="s2:Security"/> <xsd:complexType 
name="Security">
<xsd:sequence>
<xsd:element minOccurs="0" maxOccurs="1" name="UsernameToken" 
type="s2:UsernameToken"/>
</xsd:sequence>
</xsd:complexType>
<xsd:complexType name="UsernameToken">
<xsd:sequence>
<xsd:element minOccurs="0" maxOccurs="1" name="Username" 
type="xsd:string"/>
<xsd:element minOccurs="0" maxOccurs="1" name="Password" 
type="xsd:string"/>
</xsd:sequence>
</xsd:complexType>
</xsd:schema>

WSDL Message
<wsdl:message name="PUTSecurity">
<wsdl:part name="Security" element="s2:Security"/>
</wsdl:message>

WSDL Input in Binding
<soap:header message="tns1:PUTSecurity" part="Security" 
use="literal"/>

For example:
<wsdl:binding name="ProcessPackageProcess_EP" 
type="tns1:ProcessPackageProcess">
<soap:binding style="rpc" transport="http://schemas.xmlsoap.org/soap/
http"/>
<wsdl:operation name="CatchMessageEvent">
<wsdl:documentation/>
<soap:operation style="rpc" soapAction="CatchMessageEvent"/>
<wsdl:input>
<soap:header message="tns1:PUTSecurity" part="Security" 
use="literal"/>
<soap:body use="literal" parts="in1"/>
</wsdl:input>
<wsdl:output>
<soap:body use="literal" parts="out1"/>
</wsdl:output>
</wsdl:operation>
</wsdl:binding>
<soap:header message="tns1:PUTSecurity" part="Security" 
use="literal"/>
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PER-714 Summary: Multiple SOAP references deployed in a single node sending different
credentials to a single SOAP service protected with Basic Authentication Policy
could result in erroneous authentication failures for some of the references even if
they are sending valid credentials.

Workaround: You can either:

● Deploy these references in different nodes

● Configure these references with different HTTP client resource instance
configurations

PER-632 Summary: For proper policy enforcement, every composite containing a web
application component must have a different context root.

Workaround: None

PER-609,

PER-623

Summary: The UsernameTokenAuthentication and WSSProvider are incompatible
policies. These policies have redundant functionality, but they cannot co-exist on the
same SOAP service.

UsernameTokenAuthentication authenticates using only the username token in the
WS-Security header.

WSSProvider authenticates using any available information in the WS-Security
header.

Both policies remove the WS-Security header from the message after successful
authentication. If both policies are in effect at the same service, when the first one
(WSSProvider) succeeds, the second (UsernameTokenAuthentication) must fail,
because the WS-Security header is no longer available. This failure causes request
messages with proper credentials to fail erroneously.

Workaround: Do not apply the policies WSSProvider and
UsernameTokenAuthentication together at the same SOAP service.

PER-583 Summary: For bundled policies added in this release, if the resource instance(s)
used in the policy is reinstalled, policy enforcement fails.

Workaround: Redeploy the application after reinstalling the resource instance(s).

PER-557 Summary: The policy AuthorizationByRole does not support nested groups.

Suppose user A is a member of group B, which is a subgroup of group C. If group C
has access permission to request an operation, and user A attempts to request that
operation, then the request fails. That is members of group B do not inherit access
permission from group C.

Workaround: Configure access permissions directly in each subgroup (in this
example, in group B).

PER-49 Summary: When configuring an LDAP Authentication resource template in
Administrator, the option to generate SAML 1.1 assertion is not supported by
platform policies.

Workaround: When configuring an LDAP Authentication resource template, accept
the default setting to generate SAML 2.0 tokens.
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RSBT-784 Summary: Open ID authentication is not supported when invoking REST Service
Bindings using the Swagger UI. Only basic authentication is supported.

Workaround: None

RSBT-779 Summary: For a REST binding, when using the POSTMAN REST client, the basic or
username token authentication policy is not enforced if you do not provide
authentication.

Workaround: None

RSBT-721 Summary: In the Swagger UI, if SSL is enabled over a REST binding that uses the
self-signed certificate and you send a request over HTTP, it returns the following
error:
TypeError: Failed to fetch

Workaround: Add the certificate as an exception in the browser.

RSBT-719 Summary: In Swagger UI, on selecting parameter content-type as application/
bjson, the schema is not populated with the correct BJSON format.

Workaround: You can manually form the request payload of type Badgerfish JSON
(application/bjson) to get a proper response.

RSBT-716 Summary: To test an endpoint, when you select the request content-type as
application/xml, an XML request payload is generated in the Swagger UI. The
payload does not include the namespace for the elements that are defined in an
imported XSD, that is, namespace is not pre-populated in the payload.

Workaround: Manually provide a namespace for such elements.

RSBT-603 Summary: When the Java property
com.tibco.amf.runtime.bindingtype.rest.extendedJsonConversion is set to
true for a runtime node in the REST Resource Configuration (.RRC) file for a
reference binding, and if the POST request contains a JSON array with exactly one
JSON element in it (as specified below), the JSON array is treated as a single, non-
array element. This results in a NullPointerException at runtime when multiple
elements are sent as part of the request.

Erroneous usage:
{"addRequestOperation": {"Arrays":[{"Key":"key1", "Value": 
"value1"}]}} 

Workaround: In the RRC file, specify multiple elements in the JSON Array element
as follows

Correct usage:
{"addRequestOperation": {"Arrays":[{"Key":"key1", "Value": "value1"},
{"Key":"key2", "Value": "value2"}]}}

With this change, the Array object is treated as a JSON array at runtime and the
NullPointerException is not seen.

RSBT-408 Summary: A Null Pointer Exception is thrown when a Pass Through Mode sample
project is deployed in RAD.

Workaround: Deploy the project in ActiveMatrix Administrator.
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RSBT-398 Summary: A REST service binding is updated after an operation is added to a
WSDL.

Workaround: None

RSBT-391 Summary: After renaming an RRC file through the Process Explorer, the name of
the file is updated in the reference > Bindings tab > Rest Resource Configuration
File link.

Workaround: None

RSBT-382 Summary: If the RRC file name begins with xml, an error is thrown while generating
the Java implementation.

Workaround: None

RSBT-371 Summary: When a context parameter is added or edited, the following message is
displayed at the promoted reference:
Regenerated context parameter mappings

When you click the message, the mappings are created but the error message does
not disappear.

Workaround: Clean the project.

RSBT-368 Summary: In the RRC file, if an operation name begins with a '/', an exception is
thrown.

Workaround: None

RSBT-363 Summary: While creating a REST binding on a promoted service, clicking Next does
not result in any action.

Workaround: Click Finish.

RSBT-358 Summary: The following data types in a generated XSD do not match the data types
in the JSON payload:

1. unsignedByte mapped to short

2. nonpositiveinteger mapped to float

3. nonnegativeinteger mapped to float

4. unsignedshort mapped to int

5. gYear mapped to short

6. negativeinteger mapped to float

7. unsignedlong mapped to float

8. positiveinteger mapped to float

9. boolean mapped to string

Workaround: Edit the XSD file manually to reflect the correct datatypes.
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RSBT-346 Summary: Error messages for duplicate resource names or operation names are not
displayed immediately when configuring a REST resource configuration (.rrc) file.
Similarly, the error message does not go away automatically when the duplicate
resource names or operation names are removed.

Workaround: Perform a clean operation.

RSBT-231 Summary: While adding a binding, when the pass through mode is enabled, a note
or warning indicating that any existing WSDL on the component reference is
replaced by the pass through WSDL is not displayed.

Workaround: None

RSBT-230 Summary: The HTTP Client textbox is not cleaned up after the resource template is
deleted from the Resource Templates folder.

Workaround: None

RSBT-58 Summary: If you upload a DAA that includes a REST binding, ActiveMatrix
Administrator does not check whether HTTP connector resource instances exist for
HTTP connectors defined for the REST binding. Later, when you attempt to deploy
this DAA, the deployment fails because of the missing resource instance.

Workaround: Create an HTTP connector resource instance in the ActiveMatrix
Administrator GUI. While configuring the REST binding in TIBCO Business Studio,
the name of the resource instance must match the user-specified HTTP connector
name.

SDS-7799 Summary: While generating a CLI script, if you add a new server, a Null Pointer
Exception is thrown.

Workaround: After adding a new server, click on the Refresh button.

SDS-7796 Summary: When an application with a SSL-enabled HTTP connector tries to connect
to a deployment server, the connection fails.

Workaround: None

SDS-7781 Summary: After you successfully migrate SOA projects from ActiveMatrix 2.x to
ActiveMatrix 3.4.0 in TIBCO Business Studio, WS_Samples of 2.x result in
implementation errors.

Workaround: None

SDS-7780 Summary: After you successfully migrate SOA projects from ActiveMatrix 2.x to
ActiveMatrix 3.4.0 in TIBCO Business Studio, DAA generation fails for the
EmployeeVacation (2.x) Sample project.

Workaround: None

SDS-7779 Summary: After you successfully migrate SOA projects from ActiveMatrix 2.x to
ActiveMatrix 3.4.0 in TIBCO Business Studio, SoapException 2.x sample project
results in implementation errors.

Workaround: None
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SDS-7776 Summary: After importing a 3.1.5 or 3.2.0 Java sample project in 3.4.0 TIBCO
Business Studio, the following error is displayed:
JAR file incompatible with JRE/JDK 1.7 due to containing entries 
with the empty name.

Workaround:

1. Open the Problems view.

2. Look for instances of the following error message:
JAR file incompatible with JRE/JDK 1.7 due to containing
entries with empty name. 

One such message is generated for each offending JAR file.

3. Right-click all these messages and select a quick fix to apply.

SDS-7763 Summary: When you launch TIBCO Business Studio in a new workspace and click
Help > Search for the first time, a NullPointer exception is returned.

Workaround: None

SDS-7729 Summary: While running Ant files in TIBCO Business Studio, the following error is
returned :
Launching <projectName><ant.deployment-build.xml' has encountered a 
problem,  
Launch configuration <projectName><ant.deployment-build.xml 
references non-existing project <projectName>

This is because of a bug in the Eclipse platform 4.7.1a (https://bugs.eclipse.org/bugs/
show_bug.cgi?id=522581).

Workaround: Run the Ant file using the Run in the same JRE as the workspace
option in the Create, manage, and run configurations dialog box. Alternatively,
change the project containing the build.xml to a Java project by adding
<nature>org.eclipse.jdt.core.javanature</nature> to the list of <natures>
in the .project file and then restart Eclipse.

SDS-7725 Summary: If the 3.4.0 TIBCO Business Studio is used to load a workspace that has
been created using 3.3.0 TIBCO Business Studio, running RAD (Rapid Application
Deployment) fails with the following error because the 3.3.0 workspace contains JRE
1.7 information:
Unsupported minor version

Workaround: Change the workspace JRE to Java 1.8.
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SDS-7685 Summary: If a Java project uses the Java 8 specific syntax in the code, the DAA file
cannot be generated with an execution environment as JavaSE-1.8. However, Java 8
syntax and compilation is supported.

Workaround: To generate the DAA file with Java 8 code, make sure the
RequiredExecutionEnvironment field in the Manifest.MF file is empty. This
allows you to create the DAA and deploy it at run time.

● For a newly created project, the RequiredExecutionEnvironment field in the
Manifest.MF file is empty.

● For an existing project, if Java 8 specific code is added, remove the
RequiredExecutionEnvironment entry in the Manifest.MF file.

SDS-7680 Summary: For a Custom Mediation task, generation of the DAA fails. Workaround:
While creating the Custom Mediation task, make sure the
RequiredExecutionEnvironment field in the Manifest.MF file is empty. This allows
you to create the DAA and deploy it at runtime.

SDS-7669 Summary: In the ActiveMatrix Administrator CLI, upgrading the existing
application did not update the Contact and Description fields in DAA.

Workaround: In the SystemNode.tra file, set the following property:
java.property.com.tibco.amx.admin.application.update.description.cont
act.during.upgrade=true

SDS-7640 Summary: When an existing project is imported into a workspace and Java 8 code is
added to it, the following error is returned while creating the DAA:
Exporting bundles failed

Workaround: To generate the DAA file with Java 8 code, make sure the
RequiredExecutionEnvironment field in the Manifest.MF file is empty. This
allows you to create the DAA and deploy it at runtime.
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SDS-6729,

SDS-6992
Summary: ActiveMatrix projects created in versions prior to 3.2.0 that use Java,
Spring or WebApp components encounter an Null Pointer Exception (NPE) dialog
when imported into any ActiveMatrix version running on JRE 1.7 or later. This is
caused by the incompatibility of JRE 1.7 with the JAR format of the DataBinding
JARs generated by ActiveMatrix versions prior to 3.3.0. This may happen if you
have upgraded to JRE 1.7 or installed an ActiveMatrix version that includes JRE 1.7,
such as version 3.3.0.

Workaround:

1. Open the Problems view.

2. Look for instances of the following error message:
JAR file incompatible with JRE/JDK 1.7 due to containing
entries with empty name.

One such message is generated for each offending JAR file.

3. Right-click on one of these messages and select a quick fix to apply. There are
three quick fixes available (all three back up old JARs):

● Fix JAR for JRE/JDK 1.7 compatibility-This option fixes only the selected JAR
(that is, the JAR you clicked to apply the quick fix).

● Fix all library JARs in project for JRE/JDK 1.7 compatibility-This option fixes
all of the offending JARs in the same project as the selected JAR (that is, the
JAR you clicked to apply the quick fix).

● Fix all library JARs in workspace for JRE/JDK 1.7 compatibility-This option
fixes all of the offending JARs in the workspace.

4. After applying a quick fix, some errors related to the component class may still
be seen. To clean up these errors, select the project that has the errors and select
Project > Clean.

SDS-6264 Summary: If the Web Application component is added by right clicking on the
composite, the Generate Servlet Implementation option is not available under the
Quick Fixes option.

Workaround: Select the Web Application component, right-click, and select
Generate Servlet Implementation.

SDS-5866 Summary: When one of the nodes participating in a high availability configuration
is stopped and an application is deployed via TIBCO Business Studio, the
deployment never completes.

Workaround: Deploy the application from ActiveMatrix Administrator. The
application state is in a partially running state instead of running - which is the
expected behavior.

SDS-3890 Summary: Sometimes, the following message is returned in the error log:
Unbanded EventLoop Exception

Workaround: None. Ignore the error.
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SVCP-84 Summary: The TIBCO ActiveMatrix Service Performance probe on the
Administrator node does not receive self-shutdown notifications sent from
TibcoHost. This occurs because the Service Performance Manager probe component
on the Administrator node responsible for such communication shuts down before
it can send the notification.

Workaround: None

TAP-16041 Summary: In the deploy-application target of application_build.xml file, if
the force attribute is set to true, then application deployment is successful even if
the required resource instance is not available. This issue is applicable if the resource
instance required for an application is defined in the policy set.

Workaround: When deploying an application, set the force attribute to false in the
deploy-application target of application_build.xml file. Setting the force
attribute to false checks for all dependencies required by an Application.

TAP-15885 Summary: Accessing ActiveMatrix Administrator Dashboards ( Dashboard >
Infrastructure) results in the following error:
Dashboard Bundle not Available. Please reload the browser. 
TypeError: Cannot read
property 'Container' of undefined

Workaround: Access ActiveMatrix Administrator Dashboards using the procedure
mentioned in "Accessing Administrator Dashboards" section of the TIBCO
ActiveMatrix Service Grid Administration guide.

TAP-15863 Summary : On Microsoft Windows, when HSQLDB is used and the Log Service is
enabled, the following error is intermittently seen in the CONFIG_HOME\tibcohost
\<instance_name>\data_3.2.x\nodes\SystemNode\logs\SystemNode.log of
the ActiveMatrix enterprise:
TIBCO-AMX-HPA-014016: Uncaught exception in thread Thread 
[LoggingThread,5,Job_Executor]
java.lang.IllegalStateException: No uri

After this error is seen, Governance > Log Viewer (logservice) does not work from
the ActiveMatrix Administrator UI and the following error is returned:
Loading log service list failed. You have no permission to visit 
logviewer or the log service admin plugin is not available.

Workaround : None

TAP-15842 Summary: If you create an enterprise that uses a messaging bus and then create an
environment that does not use the messaging bus, the Configure enterprise without
a messaging bus check box on the Admin Configuration > General tab is disabled.

Workaround: None

TAP-15834 Summary: When using the Microsoft Edge browser, when creating an Object Group
of Policy Director Governance by specifying the search criteria to find the matched
group members, if you click the + button to build the search criteria, the attribute
and operator drop-downs are not populated with the correct values.

Workaround: None
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TAP-15833 Summary: When using the Microsoft Edge browser, when building the search
criteria to find the matched group members, the X button does not clear the drop-
down boxes used to specify the search criteria.

Workaround: None

TAP-15827 Summary: If you have upgraded to ActiveMatrix 3.4.0, and then created a new Host
or Node, some default loggers are missing on the newly created Host or Node.

Workaround: Before creating the new Host, copy the
DefaultLogConfiguration.properties file on every TibcoHost instance on which
the ActiveMatrix Administrator server is running.

Copy the file from <TIBCO_HOME>\administrator\3.4\templates\ and paste it
into <CONFIG_HOME>\admin\amxadmin\private\<instanceName>\.

TAP-15822 Summary: You cannot deploy an ActiveMatrix 3.4.0 DAA on ActiveMatrix 3.3.1
Administrator, ActiveMatrix 3.3.0 Administrator or ActiveMatrix 3.3.0 Hotfix 23
Administrator that uses Java 8.

Workaround: None

TAP-15817 Summary: When using the Microsoft Edge browser on Windows 10, the Metrics
Collection Runtime dashboard is not displayed.

Workaround: None

TAP-15664 Summary: On Solaris Sparc, Get Admin Information use test of Enterprise
Deployment Health Check fails with the following error:
Couldn't obtain phys addr

Workaround: None

TAP-15645 Summary: When a TIBCO ActiveMatrix enterprise has customized system host and
system node names (for example: SystemNode1, SystemNode2, or AdminNode) and
the system node does not fully start in a TIBCO ActiveMatrix enterprise, the
following error message is displayed on the TIBCO ActiveMatrix Administrator web
page:
404 page not found

Prior to TIBCO ActiveMatrix 3.3.0 Hotfix 13, when a user tried to access a
TIBCO ActiveMatrix Administrator web page while it is still loading or
the user specified a wrong URL (but with correct IP address and port
number), a "404 page not found" HTTP error response was returned.
Starting with TIBCO ActiveMatrix 3.3.0 Hotfix 13, in the same situation, a
new 404 page is displayed. This new 404 page automatically redirects the
user to the login page once TIBCO ActiveMatrix Administrator is fully
initialized and ready for service. However, this feature applies only to
environments where the System Nodes use the default node names, that
is, SystemNode and SystemNodeReplica. For System Nodes with
customized node names, the old behavior ("404 page not found" error
page) remains.

Workaround: Periodically, refresh the ActiveMatrix Administrator web page to
determine whether ActiveMatrix Administrator was completely initialized and is
ready for service.
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TAP-15563 Summary: After upgrading ActiveMatrix Administrator from 3.1.5 to 3.4.0, you can
start or stop a host from the ActiveMatrix Administrator GUI. However, 3.1.5 hosts
that are not upgraded yet, cannot be started or stopped from the ActiveMatrix
Administrator GUI.

Workaround: Start or stop the host by using the tibcohost command.

TAP-15523 Summary: TIBCO ActiveMatrix Administrator > Infrastructure > Health Check
page does not open in Internet Explorer. However, it displays a link to open the
page in a new tab.

Workaround: Open http://localhost:8120/amxadministrator/
amxmonitor.jsp in a new tab to view the Health Check page.

TAP-15503 Summary: In the Google Chrome browser, when creating an Object Group of Policy
Director Governance by specifying the search criteria to find the matched group
members, if you click the + button to build the criteria, the attribute drop-down box
is not populated with the correct values.

Workaround: None

TAP-15488 Summary: In TIBCO ActiveMatrix Administrator, some description fields do not
work with Chrome 66.0.3359.139 or higher versions.

Workaround: None

TAP-15420 Summary: In TIBCO ActiveMatrix Administrator, when you navigate to
Infrastructure > Enterprise Status > Application tab and click Download Logs, the
requested application logs are not downloaded and the following error is displayed:
Cause: java.util.concurrent.TimeoutException.

Workaround: None

TAP-15060 Summary: After successfully downgrading to a previous version, you must
uninstall the higher version.

Workaround: None

TAP-14874 Summary: After reconnecting to EMS, ActiveMatrix Administrator shows the
correct status but the Action History continues to show "In Progress(n)".

Workaround: None

TAP-14772 Summary: Even when the Notification transport update was completed successfully
using the ActiveMatrix Administrator CLI, the following error message was
displayed:
TIBCO-AMX-ADMIN-021085: Failed to update the notification 
transport!, Caused by:
TIBCO-AMX-ADMIN-021281: The number of hosts in this enterprise is 
more than 10. 
Please use the Administrator Command Line Interface for updating the 
Notification Transport. 

Workaround: None
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TAP-14766 Summary: Ideally, in TIBCO ActiveMatrix, you should update the Notification
Transport for all TIBCOHosts in the enterprise. If a particular TIBCOHost has to be
updated using the hosts option from ActiveMatrix Administrator CLI, you must
update the SystemHost's Notification Transport first, and then proceed with
updating the Notification Transport for other TIBCOHosts.

If SystemHost is not updated first, while updating Remote TIBCOHosts,
ActiveMatrix Administrator CLI might show the update as having been completed
successfully, but the TIBCOHosts might not be updated.

Workaround: Update the Notification Transport for the SystemHost first.

TAP-14699 Summary: When the Java property
java.property.com.tibco.amx.decouple.Manual.Nodes is not set to true in the
tibcohost.tra file, the status of a Manual Node is marked as Stopped even when it
is Running (Node process remains in task manager).

Workaround: None

TAP-14242 Summary: When you log in to ActiveMatrix Administrator server using SSL-
enabled LDAP authentication realm, returns a non-fatal ClassNotFoundException
in the SystemNode log.

Workaround: None

TAP-14052 Summary: The uninstall action does not work as expected with a wildcard if the
given feature versions have strict (1.0.0) and qualified strict (1.0.0.01) versions
together.

In a wildcard behavior, the following behavior is observed:

If the user has two versions for the same featureId in the form of 1.0.0 (Strict version
without qualifier) and 1.0.0.001 (Strict version with qualifier), precedence is given to
1.0.0.001 only and 1.0.0 is not uninstalled.

Workaround: To uninstall 1.0.0 explicitly, perform the same action again.

TAP-13994 Summary: The Hostname in the Management URL of a TibcoHost instance gets
replaced with the Hostname of its source TibcoHost, when TibcoHost Instance is
installed successfully.

Workaround: None

TAP-13942 Summary: On the <Host> -> <ResourceInstance> page and Shared Objects ->
Resource Templates -> Resource Instances tab, environment or duplicate node
information is not displayed.

Workaround: On the Details pane of <Host> -> <ResourceInstance> page and
Shared Objects > Resource Templates > Resource Instances tab, navigate to the tree
view in the left side pane. This tree view provides the exact node name:
<Environment Name>_<node name>.
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TAP-13910 Summary: While exporting Logging Appenders, one logging appender
<CustomName>_Root is exported when the following conditions are met:

● host name of the replicated admin server is changed from the default
SystemHostReplica to a custom name.

● Include System Objects option is NOT selected.

Workaround: None

TAP-13828 Summary: When installing or uninstalling a node, the most recent state of the node
is displayed in the Action History column and not in the Node State column. For
example, after uninstalling a node, the Node State is Not Installed while the action
is in progress. This happens when there are incomplete tasks for action, but the node
state has already changed.

Workaround: Refer to the most recent state displayed in the Action History column
instead of the Node State column.

TAP-13777 Summary: If the TibcoHost name in the ActiveMatrix Administrator GUI and run
time is different and the TibcoHost name from the ActiveMatrix Administrator GUI
is specified in the CLI data, the install/start/uninstall actions fail.

Workaround: None

TAP-13696 Summary: If a Management URL is unreachable and you try to unregister the
TibcoHost, a warning message about the unreachable URL is not displayed.

Workaround: None

TAP-12878 Summary: If you import a resource template into an upgraded user application that
did not previously contain a resource template (that is, if no resource templates had
previously been imported into the application), the scope of the imported resource
template is automatically set to Global, rather than Application. This occurs even if
you specify Application scope in the CLI.

Workaround: After the resource template is imported (to Global scope), change its
scope as required (to Application scope, for example) in the ActiveMatrix
Administrator UI. To do this:

1. Go to Shared Objects > Resource Templates.

2. Select the imported resource template.

3. Click Change Scope, and change the scope to the Application or Environment
level as required.
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TAP-12860 Summary: If you have a main process and a subprocess application and one or more
dependent main process applications deployed in ActiveMatrix version 3.1.5 (and
any TIBCO® BPM Enterprise version between 1.3.0 and 2.1.0), then upgrade the
BPM platform version to TIBCO® BPM Enterprise 2.2.0 (ActiveMatrix 3.3.0), and
subsequently attempt to upgrade the subprocess, you will see a warning similar to
the following example:
TIBCO-AMX-ADMIN-012430: Provided capability 
'com.example.my.subprocess.pe.capability' provided by component 
'MySubAppProcessFlow' cannot be removed. It is being used by the 
following components:Component 'MyMainAppProcessFlow' from 
application 'com.example.my.mainapp.process

This warning is issued erroneously and can be safely ignored. The subprocess is
upgraded successfully and the main processes runs as expected, provided the
subprocess maintains the same major version number as before.

Workaround: None

TAP-12858 Summary: The logging configuration of a node, host, or application (which is stored
in the node, host, or application’s log4j.xml; for example, node-log4j.xml) might
enter into an inconsistent state if the node, host, or application uses a JMS appender
that is configured with an SSL-enabled EMS server. In this case, the logging
configuration uses an HTTP URL to refer to a keystore that’s hosted on the
Administrator. This HTTP URL is the internal HTTP connector URL of the
Administrator.

Changing the configuration of the internal HTTP connector (for example, to enable
SSL or change the port number) causes the URL configured in the logging
configuration (log4j.xml) to become invalid or out of sync. The logging
configuration of each affected node, host, or application needs to be updated or it
will fail to connect to EMS. Currently this is not done automatically.

Workaround: You must manually save and apply the logging configuration for each
node, host, or application that uses a JMS appender. To do this:

1. In the ActiveMatrix Administrator UI, go to the logging configuration for the
node, host, or application that is in the situation described above.

2. Change a value in the logging configuration that makes the node, host, or
application go out of sync. Then, click Save.

3. To push the new logging configuration with a new HTTP URL, to the node, host,
or application, click Apply.

TAP-12738 Summary: If you delete a binding using the ActiveMatrix Administrator UI, it is still
visible in the SPM dashboard with a Down status. This occurs because the Delete
notification for the ActiveMatrix binding component is not being emitted.

Workaround: None

TAP-12714 Summary: ActiveMatrix Administrator does not properly undeploy applications
with missing feature dependencies.

Workaround: To avoid this issue, go to Node > Configuration > Features and
remove the feature with Marked for Install and a blank value for Type.

51

TIBCO ActiveMatrix® Service Grid Release Notes



Key Summary

TAP-12702 Summary: If you use TIBCO Configuration Tool to edit the ActiveMatrix
Administrator database settings, the following harmless error might appear in
SystemNode.log:
Could not open Hibernate Session for transaction. 

Workaround: None

TAP-12319 Summary: When deploying an application, ActiveMatrix Administrator
automatically installs resource instances if there are resource templates with scope
to the application. If the resource template installation fails, then application
deployment also fails. For example, if the HTTP connector has a port conflict, it fails
to start.

Workaround: For HTTP connector port conflicts use substitution variables to assign
different port numbers for each node to avoid port conflicts. Then, uninstall the
application and redeploy it.

TAP-12087 Summary: Making changes to the configuration of a JDBC service resource template
that is a dependency for a running application might cause that application to enter
a Stopped state.

Workaround: Manually restart the stopped application.

TAP-10830 Summary: When wiring a reference to a service in the same application that has a
SOAP binding using an HTTP Connector that does not exist results in the following
exception:
Error generating the WSDL for binding SOAPService_Binding1, Caused 
by: Could not find resource instance with name httpConnector when 
generating WSDL for binding SOAPService_Binding1 on service 
NewService

Workaround: Create the HTTP connector before creating the application.

TAP-10800 Summary: When creating an Administrator server with an Oracle database the
following error messages are seen in the SystemNode log files:
SystemNode 30 Jul 2012 16:42:48,287 [WAR-Deployer-Thread] [ERROR] 
org.hibernate.tool.hbm2ddl.SchemaUpdate - Unsuccessful: create index 
AdmnCnfig_sttsNtifictinTrnsprt on "ADMINCONFIG" 
("NTFCTNTRNSPRT_STTSNTFCTNTRNS_D")
SystemNode 30 Jul 2012 16:42:48,287 [WAR-Deployer-Thread] [ERROR] 
org.hibernate.tool.hbm2ddl.SchemaUpdate - ORA-00955: name is already 
used by an existing object
SystemNode 30 Jul 2012 16:42:48,303 [WAR-Deployer-Thread] [ERROR] 
org.hibernate.tool.hbm2ddl.SchemaUpdate - Unsuccessful: create index 
AMXdminsrPrfrncs_prvisnvslctin on "AMXADMINUSERPREFERENCES" 
("PRVISNVSLCTIN_PRVISNVSLCTIN_ID")
SystemNode 30 Jul 2012 16:42:48,303 [WAR-Deployer-Thread] [ERROR] 
org.hibernate.tool.hbm2ddl.SchemaUpdate - ORA-00955: name is already 
used by an existing object
SystemNode 30 Jul 2012 16:42:48,319 [WAR-Deployer-Thread] [ERROR] 
org.hibernate.tool.hbm2ddl.SchemaUpdate - Unsuccessful: create index 
ApplicationFolder_childFolders on "APPLICATIONFOLDER" 
("APPLICATIONFOLDER_PARENT_E_ID")
SystemNode 30 Jul 2012 16:42:48,319 [WAR-Deployer-Thread] [ERROR] 
org.hibernate.tool.hbm2ddl.SchemaUpdate - ORA-01408: such column 
list already indexed

Workaround: These errors can be safely ignored as the indexes are created.
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TAP-10767 Summary: HTTP Connector resource instances that are referenced by properties
whose names are not specific, such as HttpInboundConnectionConfig or
httpConnector, are not recognized by Administrator as HTTP Connectors while
displaying information. As a result these HTTP Connectors are not displayed in the
Administrator UI as dependencies where expected.

Also, you can delete any such HTTP Connector even when it has dependent
applications.

Workaround: Use property names such as HttpInboundConnectionConfig or
httpConnect to refer to HTTP Connectors resource instances. Additionally when
deleting HTTP Connector resource instances, manually check whether other
applications are dependent on it.

TAP-10751 Summary: Executing the scripts generated by the DDL Script Generator for
Microsoft SQL Server displays errors reporting a failure to create foreign key
constraints.

Also, even if the generated scripts are not used, error messages are seen in the
SystemNode log file logged in SystemNode.log regarding failure to create foreign
key constraints.

Workaround: None. These errors can be ignored as a failure to create foreign key
constraints do not impact product functionality.

TAP-10663 Summary: Heterogeneous environments with mixed JREs are not supported. Sun
JRE is not compatible with IBM JRE when it comes to storing secret keys in a Java
keystore. This causes a problem when the server running on Sun JRE stores a user
name and password in its global identity keystore and a host and node running on
IBM JRE attempts to access that user name and password. The reverse,
Administrator JRE would have the same problem.

Workaround: Ensure that, TibcoHost instances, and nodes are all using JREs
provided by the same vendor.

TAP-7644 Summary: You might see the following error message when undeploying an
application:
[ERROR] com.tibco.amf.admin.server.axis2.RPCMessageReceiver -
Error occurred in Administrator... about to throw AxisFault for this 
exception 

Workaround: Refresh the browser. This error message can be safely ignored.

TAP-7571 Summary: Users who have permissions only to view an application and an
environment but do not have permissions to view a node are not able to see the list
of selected nodes when distributing an application.

Workaround: Permissions to view the node have to be explicitly granted by a
superuser.

TAP-7423 Summary: You might see errors in dashboard dialog box when using the
Dashboard.

Workaround: Click OK to proceed using the Dashboard. This error message can be
safely ignored.
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TAP-6584 Summary: When the extended monitoring is enabled the two new periodic
windows (24 hours and 7 days) do not show on some Dashboard tabs.

Workaround: Refresh the browser.

TAP-5653 Summary: Updating the value of a substitution variable for the Timeout property in
a JMS or SOAP/JMS binding in a deployed application does not take effect after the
application is redeployed.

Workaround: Undeploy and deploy the application.

TAP-4890 Summary: In the dashboards, a text filter is ignored when you maximize or
minimize a gadget.

Workaround: Re-enter the text filter.

TAP-4645 Summary: On the Dashboards > Infrastructure screens, resource instances cannot
be filtered by promoted reference or promoted service.

Workaround: In the Application Screen, check properties of the reference or service
bindings.

TOOL-1895 Summary: If you update JRE by using the TIBCO Configuration Tool, the
TIBCOConfigurationTool.ini and TIBCOBusinessStudio.ini files are not
updated with new JRE HOME. Because of this, launching TIBCO Configuration Tool
and TIBCO ActiveMatrix Business Studio fails.

Workaround: None

WSBT-1149 Summary: Web service reliable messaging does not work in TIBCO ActiveMatrix
Service Grid 3.4.0.

Workaround: None

WSBT-1134 Summary: In case of SOAP bindings, context parameters of Type "Message" can be
defined using "Message/Part" from the WSDL used by the binding. These message
context parameters can be used for declared unbound SOAP headers. The body of a
SOAP message is also defined using "Message/Part" configuration from the WSDL
used by the binding. Using the same "Message/Part" configuration for the SOAP
header and the SOAP body results in incorrect behavior while generating the SOAP
message, that is, either the <Header> or the <Body> element might be empty. This
applies to SOAP request, SOAP response and SOAP fault messages.

For example, if the body of the SOAP response is configured with
Message="GetSOAPResponse"/Part = "param1" in the WSDL and the context
parameter of Type "Message" is defined with the same Message/Part Definition
"GetSOAPResponse/param1", the generated SOAP response message might contain
empty <Header> or <Body> element.

Workaround: None. However, if distinct "Message/Part" pairs are used for SOAP
header and body, this issue does not occur. For example, if the body of the SOAP
response is configured with Message="GetSOAPResponse"/Part = "param1" in
the WSDL and the context parameter of Type "Message" is defined with Message/
Part Definition "GetSOAPHeader/headerparam1", the generated SOAP
response message contains both <Header> and <Body> elements.
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WSBT-1112,

WSBT-1117

Summary: For SOAP bindings containing all in-only operations, the Enable
Response Message Validation field in ActiveMatrix Administrator and TIBCO
Business Studio is not applicable.

Workaround: At present, this field is not disabled for SOAP bindings containing all
in-only operations and, if selected, does not have any effect.

WSBT-888 Summary: Substitution Variables are not available for all the fields in SOAP Service
and Reference Bindings. On the Service side, Substitution Variables are supported
for the following fields:

● Enable Request Message Validation

● Enable Response Message Validation

● Sender Identified Expression

On the Reference side, Substitution Variables are supported for the following fields:

● Enable Request Message Validation

● Enable Response Message Validation

● Filespec of Endpoint URL

Workaround: None

WSBT-881 Summary: Policies and policy sets cannot be added, edited, or deleted via the
ActiveMatrix Administrator UI. Policy set properties can be viewed but not added,
edited, or deleted.

Workaround: Edit policy sets and properties in TIBCO Business Studio.

XPD-5331 Summary: Deploying DAAs or applications with the following characteristics in
TIBCO® BPM Enterprise 2.2.0 runtime might result in a No request message is
found to add the user name token error at runtime:

● The DAA or application was created in TIBCO Business Studio prior to version
3.6.0.

● The DAA or application contains a Web Service invocation (that is, the
application is a consumer)

● The application has a User nameToken policy type in its security

Workaround: Open the project in TIBCO Business Studio 3.6.0, build the DAA, and
upgrade the existing application.

XPD-1858 Summary: When you open a native file browse dialog box on RedHat Linux for the
first time, it crashes.

Workaround: Type the path to the file in the text control.
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TIBCO Documentation and Support Services

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation website, mainly in
HTML and PDF formats.
The website is updated frequently and is more current than any other documentation included with the
product.

Product-Specific Documentation

The following documentation for TIBCO ActiveMatrix® Service Grid is available on the TIBCO
ActiveMatrix® Service Grid product documentation page.

Use of the following features, installation profiles and development tools requires a TIBCO ActiveMatrix
Service Grid license:

● TIBCO ActiveMatrix Policy Director Governance, TIBCO ActiveMatrix SPM Dashboard, and TIBCO
ActiveMatrix SPM Runtime Server profiles; and

● TIBCO ActiveMatrix Service Grid development tools for Java, Webapp and Spring components.

Customers with only a TIBCO ActiveMatrix Service Bus license are not licensed to use these features, tools
or profiles.

The following documents form the documentation set:

● TIBCO ActiveMatrix Service Grid Concepts: Read this manual before reading any other manual in the
documentation set. This manual describes terminology and concepts of the platform. The other manuals
in the documentation set assume you are familiar with the information in this manual.

● TIBCO ActiveMatrix Service Grid Development Tutorials: Read this manual for a step-by-step introduction
to the process of creating, packaging, and running composites in TIBCO Business Studio.

● TIBCO ActiveMatrix Service Grid Composite Development: Read this manual to learn how to develop and
package composites.

● TIBCO ActiveMatrix Service Grid Java Component Development: Read this manual to learn how to configure
and implement Java components.

● TIBCO ActiveMatrix Service Grid Mediation Component Development: Read this manual to learn how to
configure and implement Mediation components.

● TIBCO ActiveMatrix Service Grid Mediation API Reference: Read this manual to learn how to develop
custom Mediation tasks.

● TIBCO ActiveMatrix Service Grid Spring Component Development: Read this manual to learn how to
configure and implement Spring components.

● TIBCO ActiveMatrix Service Grid WebApp Component Development: Read this manual to learn how to
configure and implement Web Application components.

● TIBCO ActiveMatrix Service Grid REST Binding Development: Read this manual to learn how to configure
and implement REST components.

● TIBCO ActiveMatrix Service Grid Administration Tutorials: Read this manual for a step-by-step
introduction to the process of creating and starting the runtime version of the product, starting TIBCO
ActiveMatrix servers, and deploying applications to the runtime.

● TIBCO ActiveMatrix Service Grid Administration: Read this manual to learn how to manage the runtime
and deploy and manage applications.

● TIBCO ActiveMatrix Service Grid Hawk ActiveMatrix Plug-in: Read this manual to learn about the Hawk
plug-in and its optional configurations.
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● TIBCO ActiveMatrix Service Grid Policy Director Governance Custom Actions: Read this manual to learn
how you can configure and enforce policies for ActiveMatrix and external services hosted in third party
containers, using TIBCO ActiveMatrix Policy Director Governance.

● TIBCO ActiveMatrix Service Grid Service Performance Manager API Reference: Read this manual to learn
how to use the SPM APIs.

● TIBCO ActiveMatrix Service Grid Error Codes: Read this manual to know more about the error messages
and how you could use them to troubleshoot a problem.

● TIBCO ActiveMatrix Service Grid Installation and Configuration: Read this manual to learn how to install
and configure the software.

● TIBCO ActiveMatrix Service Grid Security Guidelines: Read this manual to learn more about security
guidelines and recommendations for TIBCO ActiveMatrix Service Grid.

● TIBCO ActiveMatrix Service Grid Release Notes: Read this manual for a list of new and changed features,
steps for migrating from a previous release, and lists of known issues and closed issues for the release.

How to Contact TIBCO Support

Get an overview of TIBCO Support. You can contact TIBCO Support in the following ways:

● For accessing the Support Knowledge Base and getting personalized content about products you are
interested in, visit the TIBCO Support website.

● For creating a Support case, you must have a valid maintenance or support contract with TIBCO. You
also need a user name and password to log in to TIBCO Support website. If you do not have a user
name, you can request one by clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee subject matter
experts to share and access their collective experience. TIBCO Community offers access to Q&A forums,
product wikis, and best practices. It also offers access to extensions, adapters, solution accelerators, and
tools that extend and enable customers to gain full value from TIBCO products. In addition, users can
submit and vote on feature requests from within the TIBCO Ideas Portal. For a free registration, go to 
TIBCO Community.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR
PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS
OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE
AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER
LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE
SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH
SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER LICENSE AGREEMENT, THE
LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE OF THIS DOCUMENT IS
SUBJECT TO THOSE TERMS AND CONDITIONS, AND YOUR USE HEREOF SHALL CONSTITUTE
ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this document
may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, TIBCO O logo, ActiveMatrix, Business Studio, Enterprise Message Service, and
Hawk are either registered trademarks or trademarks of TIBCO Software Inc. in the United States and/or
other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle and/or its
affiliates.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system platforms
for a specific software version are released at the same time. See the readme.txt file for the availability of
this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS.
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL
BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE
IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED
IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING
BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer to
TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 2010-2022. TIBCO Software Inc. All Rights Reserved.

58

TIBCO ActiveMatrix® Service Grid Release Notes

https://www.tibco.com/patents

	Contents
	New Features
	Changes in Functionality
	Changes in Platform Support
	Deprecated and Removed Features
	Migration and Compatibility
	Closed Issues
	Known Issues
	TIBCO Documentation and Support Services
	Legal and Third-Party Notices

